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Prefacio
v

Gracias por comprar este producto Topcon. Los materiales que se 
ofrecen en el presente Manual (el “Manual”) han sido preparados 
por Topcon Positioning Systems, Inc. (“TPS”) para los propietarios 
de productos Topcon. El presente Manual ha sido diseñado para 
facilitar a los propietarios el uso del HiPer+ y su uso se encuentra 
sujeto a los siguientes términos y condiciones (los “Términos y 
Condiciones”).

AVISO
Por favor lea cuidadosamente los presentes 
Términos y Condiciones.

Términos y Condiciones
USO PROFESIONAL – Este producto ha sido diseñado para ser 
utilizado por un profesional. Es necesario que el usuario sea un 
topógrafo profesional o cuente con un amplio conocimiento de la 
topografía para que pueda entender las instrucciones para el usuario 
y las instrucciones de seguridad antes de operar, inspeccionar o 
ajustar el equipo. Siempre debe utilizar vestimenta de seguridad 
apropiada (calzado de seguridad, casco de seguridad, etc.) cuando 
opere el equipo.

DERECHOS DE AUTOR – Toda la información contenida en el 
presente Manual es propiedad intelectual de TPS y está sujeta a los 
derechos de autor de TPS. Se reservan todos los derechos. Usted no 
puede utilizar, leer, copiar, guardar, mostrar, crear obras derivadas, 
0-0526-SP www.topconpositioning.com
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vender, modificar, publicar, distribuir, o permitir el acceso de 
terceros a los gráficos, contenido, información o datos incluidos en 
este Manual sin el expreso consentimiento por escrito de TPS y 
únicamente podrá utilizar esta información para el cuidado y 
operación de su HiPer+. La información y datos contenidos en el 
presente Manual constituyen una propiedad valiosa de TPS y han 
sido desarrollados gracias a la inversión considerable de trabajo, 
tiempo y dinero, y son resultado de la selección original, 
coordinación, y adaptación realizadas por TPS.

MARCAS REGISTRADAS – Legacy-E™, PG-A1™, HiPer+™, 
Topcon® y Topcon Positioning Systems™ son marcas registradas 
de TPS. Windows® es una marca registrada de Microsoft 
Corporation. Bluetooth™ es una marca de propiedad de Bluetooth 
SIG, Inc. utilizada por Topcon Positioning Systems, Inc. bajo 
licencia. Otros productos y nombres de compañías a las que se hace 
mención en el presente documento son marcas registradas de sus 
respectivos propietarios.

LIMITACIÓN DE RESPONSABILIDAD – CON EXCEPCIÓN 
DE LAS GARANTÍAS QUE SE DESCRIBEN EN UN 
APÉNDICE O EN LA TARJETA DE GARANTÍA QUE 
ACOMPAÑA AL PRODUCTO, EL PRESENTE MANUAL Y EL 
HIPER+ SE ENTREGAN “TAL COMO ESTÁN”. NO EXISTEN 
OTRAS GARANTÍAS. TPS DESCONOCE CUALQUIER 
GARANTÍA IMPLÍCITA DE COMERCIALIZACIÓN O 
IDONEIDAD PARA UN USO O FIN PARTICULAR. TPS Y SUS 
DISTRIBUIDORES NO ASUMIRÁN RESPONSABILIDAD 
ALGUNA POR ERRORES TÉCNICOS O EDITORIALES U 
OMISIONES COMETIDAS EN EL PRESENTE DOCUMENTO; 
NI EN CASO DE DAÑOS INCIDENTALES O QUE SE 
DERIVEN DE LA PROVISIÓN, RENDIMIENTO O USO DE 
ESTE MATERIAL O DEL HIPER+. DICHOS DAÑOS 
INCLUYEN, AUNQUE NO SE ENCUENTRAN LIMITADOS A 
Topcon Manual de Instrucciones del HiPer+
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PÉRDIDA DE TIEMPO, PÉRDIDA O DESTRUCCIÓN DE 
DATOS, PÉRDIDA DE UTILIDADES, AHORROS O 
GANANCIAS, O PÉRDIDAS GENERADAS POR EL USO DE 
PRODUCTOS. ADEMÁS, TPS NO SE RESPONSABILIZA POR 
DAÑOS O COSTOS EN LOS QUE SE INCURRA EN 
RELACIÓN CON LA OBTENCIÓN DE PRODUCTOS O 
SOFTWARE SUBSTITUTOS, RECLAMOS DE TERCEROS, 
INCONVENIENCIA, U OTROS COSTOS. EN CUALQUIER 
CASO, TPS NO SE RESPONSABILIZARÁ POR LOS DAÑOS U 
OTROS A USTED O A CUALQUIER OTRA PERSONA O 
ENTIDAD POR UN MONTO SUPERIOR AL PRECIO DE 
COMPRA DEL HIPER+.

CONVENIO DE LICENCIA – El uso de programas de 
computadoras o software suministrados por TPS o que hayan sido 
descargados de un sitio web de TPS (el “Software”) en relación con 
el HiPer+ constituye la aceptación de los Términos y Condiciones 
contenidos en el presente Manual e indica su conformidad de 
continuar aceptando los presentes Términos y Condiciones. Se le 
otorga al usuario una licencia personal, no exclusiva e intransferible 
de utilizar dicho Software de conformidad con los términos 
señalados en el presente documento y en cualquier caso únicamente 
con un solo HiPer+ o una sola computadora. Usted no deberá 
entregar o transferir el Software o esta licencia sin el expreso 
consentimiento de TPS. Esta licencia tendrá validez hasta que se dé 
por terminada. Usted puede dar por terminada la licencia en 
cualquier momento mediante la destrucción del Software y el 
Manual. TPS podría dar por terminada la licencia si usted deja de 
cumplir con cualquiera de los Términos y Condiciones. Usted se 
compromete a destruir el Software y el manual después de concluir 
con el uso del HiPer+. Todos los derechos de propiedad, derechos 
de autor y de propiedad intelectual del Software le pertenecen a 
TPS. Si considera que los términos de esta licencia no son 
aceptables, devuelva el software y el manual sin utilizar.
7010-0526-SP www.topconpositioning.com
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CONFIDENCIALIDAD – El presente Manual, sus contenidos y el 
Software (denominados en conjunto, “Información Confidencial”) 
constituyen información confidencial y son propiedad de TPS. 
Usted se compromete a tratar la Información Confidencial de TPS 
con un nivel de cuidado no menos estricto que el que utilizaría para 
proteger sus documentos secretos de comercialización más 
valiosos. Nada de lo contenido en este párrafo implica que usted 
quede impedido de divulgar Información Confidencial a sus 
empleados que sea necesaria o conveniente para la operación o 
cuidado del HiPer+. Dichos empleados también deben mantener de 
manera confidencial la Información de Confidencialidad. En el caso 
que usted se vea legalmente obligado a divulgar la Información 
Confidencial, debe comunicárselo inmediatamente a TPS de 
manera que TPS pueda buscar una orden de protección u otro 
remedio adecuado.

SITIO WEB; OTRAS DECLARACIONES – Ninguna 
declaración contenida en el sitio web de TPS (o en cualquier otro 
sitio web) o en publicidad o literatura de TPS o hecha por un 
empleado o un contratista independiente de TPS modifica los 
presentes Términos y Condiciones (incluyendo la licencia, garantía 
y limitación de responsabilidad del Software).

SEGURIDAD – El uso inadecuado del HiPer+ puede ocasionar 
daños a personas o propiedad y/o el funcionamiento incorrecto del 
producto. El HiPer+ únicamente deberá ser reparado por los centros 
de servicio de garantía de TPS. Los usuarios deben revisar y prestar 
atención a las advertencias de seguridad contenidas en un 
Apéndice.

MISCELÁNEOS – Los Términos y Condiciones antes 
mencionados podrían ser enmendados, modificados, anulados, o 
cancelados, en cualquier momento por parte de TPS. Los Términos 
Topcon Manual de Instrucciones del HiPer+
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y Condiciones antes mencionados serán regulados, e interpretados 
de conformidad con las leyes del Estado de California, sin 
referencia al conflicto de leyes.

Información Regulatoria
Las siguientes secciones ofrecen información sobre el 
cumplimiento de este producto con las regulaciones 
gubernamentales.

Cumplimiento Clase B de la FCC
Este dispositivo cumple con la Parte 15 de las reglas FCC. La 
operación se encuentra sujeta a las dos condiciones siguientes:

1. Este dispositivo no debe causar interferencia peligrosa; y

2. Este dispositivo debe aceptar las interferencias recibidas, 
incluyendo aquellas que pudiesen provocar una operación 
indeseada.

Este equipo ha sido probado y se ha determinado que cumple 
con los límites establecidos para un dispositivo digital de Clase 
B, de conformidad con la Parte 15 de las regulaciones de la 
FCC. Estos Límites han sido diseñados para ofrecer una 
protección razonable contra una interferencia peligrosa en 
instalaciones residenciales. Este equipo genera, utiliza y puede 
emitir energía de radio frecuencia y en caso que no sea 
instalado o utilizado de conformidad con las instrucciones, 
podría causar una interferencia peligrosa a las comunicaciones 
de radio. Sin embargo, no se garantiza que no ocurra tal 
interferencia en una instalación en particular.

En caso que este equipo cause interferencia en la recepción de 
equipos de radio o televisión, lo cual puede determinarse 
apagando y encendiendo el equipo, se recomienda al usuario a 
intentar corregir la interferencia tomando una o más de las 
siguientes medidas:

• Reorientar o reubicar la antena de recepción.
7010-0526-SP www.topconpositioning.com
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• Alejar el equipo del receptor.

• Enchufar el equipo en un tomacorriente en un circuito 
diferente al utilizado para conectar el receptor.

• Consulte con el distribuidor o un técnico experimentado en 
radio/televisión y solicítele sugerencias adicionales

PRECAUCIÓN
Cualquier cambio o modificación al equipo 
que no haya sido expresamente aprobado 
efectuado la parte responsable del 
cumplimiento podría invalidar su autoridad 
para operar dicho equipo.

Requerimientos Canadienses relacionados 
con el Etiquetado de Emisiones
Este equipo digital de la Clase B cumple con todos los 
requerimientos de las Regulaciones Canadienses 
correspondientes a Equipos que Causan Interferencias.

This Class B digital apparatus meets all requirements of the 
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les 
exigences du Réglement sur le matériel brouilleur du Canada.

Convenciones utilizadas en el presente 
Manual
El presente manual utiliza las siguientes convenciones:

Ejemplo Descripción

File->Exit Haga clic en el menú File (Archivo) y después en 
Exit (Salir).

Enter Presione o haga clic sobre el botón o tecla Enter 
(Aceptar).
Topcon Manual de Instrucciones del HiPer+
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O Alterne el procedimiento para este paso.

Y Siga este paso, pero incluya esta información, 
habilite esta función, o modifique esta propiedad.

PUNTA
Información complementaria que puede 
ayudarlo a configurar, mantener, o poner en 
funcionamiento un sistema.

AVISO
Información complementaria que puede tener un 
efecto sobre la operación del sistema, 
rendimiento del sistema, mediciones o 
seguridad personal.

PRECAUCIÓN
Notificación que una acción puede tener 
efectos adversos en la operación del sistema, 
rendimiento del sistema, integridad de los 
datos o la salud personal.

ADVERTENCIA
Notificación que una acción generará el daño 
del sistema, pérdida de datos, pérdida de la 
garantía o daños personales.

PELIGRO

BAJO NINGUNA CIRCUNSTANCIA DEBE EFECTUAR 
ESTA ACCIÓN.
7010-0526-SP www.topconpositioning.com
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Capítulo 1
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Introducción
1-1
El presente capítulo describe:

• El HiPer+ (Figura 1-1)

• GPS/GLONASS y su receptor

• Funciones básicas del HiPer+ 

• Contenido y configuraciones del paquete estándar

• Componentes del HiPer+

• El Archivo Autorizado de Opciones (OAF)

Figura 1-1. Receptor HiPer+
 7010-0526-SP www.topconpositioning.com
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Descripción General
El HiPer+ de Topcon Positioning Systems es un receptor GPS+ de 
doble frecuencia diseñado para ser el receptor más avanzado y 
compacto del mercado topográfico. El HiPer+ es un receptor multi-
funciones y multi-propósito diseñado para mercados de precisión. 
El término mercados de precisión hace referencia a equipos, sub-
sistemas, componentes y software para topografía, construcción, 
mapeo comercial, ingeniería civil, agricultura de precisión y 
construcción en tierra y control de maquinaria para agricultura, 
mapeo fotogramétrico, hidrografía y todo uso que razonablemente 
se relacione con los que se han mencionado anteriormente.

El HiPer+ puede recibir y procesar señales tanto L1 como L2, 
mejorando la precisión de sus puntos y posiciones de 
levantamiento. El componente GPS+ de los receptores HiPer+ 
indica que usted tiene acceso a los satélites GPS (Sistema de 
Posicionamiento Global) de los Estados Unidos y a los satélites 
GLONASS (Sistema Global de Navegación Satelital) de la 
Federación Rusa, es decir, aumenta el número de satélites que 
pueden ser detectados por su receptor, mejorando, de esta manera, 
la precisión de sus puntos de levantamiento, aumentando la 
productividad y reduciendo el costo.

La doble frecuencia y las características GPS+ del HiPer+ se 
combinan para ofrecerle el único sistema cinemático en tiempo real 
(RTK) preciso para líneas de base cortas y largas. Otras 
características más, entre las que se incluyen la mitigación del 
efecto multipath y el rastreo co-op, garantizan la recepción con un 
follaje denso y con baja fuerza de señal. El receptor HiPer+ ofrece 
la funcionalidad, precisión, disponibilidad e integridad requeridas 
para una colección de datos rápida y sencilla.
Topcon Manual de Instrucciones del HiPer+
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Principios de Operación
Si el usuario utiliza el receptor GPS correcto, podrá efectuar 
levantamientos con un posicionamiento preciso y exacto, un 
requerimiento indispensable para cualquier proyecto topográfico.

Esta sección le ofrece una descripción general del GPS y de las 
funciones del receptor con el objeto de ayudarlo a entender y 
aplicar los principios GPS para que pueda sacarle el máximo 
provecho a su receptor.

Descripción General del GPS
El Sistema de Posicionamiento Global (GPS), el cual es 
regulado por el Departamento de Defensa (DoD) de los Estados 
Unidos, está formado por una red de hasta 28 satélites (al 
momento de imprimir este manual) que orbitan la tierra cada 12 
horas. El Sistema Global de Navegación Satelital (GLONASS), 
es la contraparte del Ministerio de Defensa de la Federación 
Rusa para el GPS. En cualquier momento, con un ángulo 
estándar de 15 grados, hasta 10 ó 12 satélites son visibles en 
cualquier punto de la tierra. Cuando un receptor también rastrea 
satélites GLONASS, entre 10 y 16 satélites son visibles.

La red GPS y GLONASS tiene tres componentes:

• Espacio – Satélites GPS y GLONASS orbitando 
aproximadamente a 12,000 millas náuticas sobre la Tierra y 
está equipados con un reloj y un radio. Estos satélites 
transmiten información digital (efemérides, almanaques, 
correcciones de frecuencia de tiempo, etc.).

• Usuario – La comunidad civil y militar que utiliza los 
receptores GPS/GLONASS y los satélites correspondientes 
para calcular posiciones.

• Control – Estaciones terrestres ubicadas alrededor de la 
tierra que cargan datos, incluyendo correcciones de reloj y 
efemérides nuevas (posiciones satelitales como una función 
P/N 7010-0526-SP www.topconpositioning.com
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de tiempo) para asegurar que los satélites transmitan 
correctamente los datos.

Los receptores GPS utilizan datos de efemérides y almanaque 
para calcular posiciones precisas y las posiciones de sus puntos 
de levantamiento.

Calcular Posiciones

Una vez que el receptor capta un satélite, empieza a 
registrar mediciones y recibir información digital diversa 
(efeméride, almanaque, etc.) transmitida por los satélites. 
Para calcular una posición, los receptores utilizan la 
siguiente fórmula básica:

Velocidad x Tiempo = Distancia

Donde Velocidad es la rapidez con la que viajan las ondas 
radiales (es decir, la velocidad de la luz) y Tiempo es la 
diferencia entre el tiempo de transmisión de señal y el 
tiempo de recepción de la misma.

Para calcular posiciones 3-D absolutas: latitud, longitud, y 
altitud, el receptor debe captar cuatro satélites. En un 
escenario mixto, GPS y GLONASS, el receptor debe captar 
al menos cinco satélites para obtener una posición absoluta.

Para garantizar una tolerancia a las fallas utilizando sólo 
GPS o sólo GLONASS, el receptor debe captar un quinto 
satélite.   Seis satélites ofrecerán una tolerancia a las fallas 
en escenarios mixtos. Generalmente, el número de satélites 
GPS y GLONASS que pueden observarse no supera los 
veinte (20).

Una que vez captado un satélite, el receptor colecta 
efemérides y almanaques, y guarda esta información en su 
NVRAM (RAM no volátil).

• Los satélites GPS y GLONASS transmiten datos de 
efemérides cíclicamente, con un intervalo de 30 
segundos.
Topcon Manual de Instrucciones del HiPer+
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• Los satélites GPS transmiten datos de almanaque 
cíclicamente con un intervalo de 12.5 minutos; los 
satélites GLONASS transmiten datos de almanaque 
cíclicamente con un intervalo de 2.5 minutos.

Posicionamiento GPS

Calcular una posición precisa requiere los tres elementos 
siguientes:

• Precisión – La precisión de una posición depende del 
número, integridad de la señal y ubicación (también 
conocida como Dilución de Precisión o DOP) de los 
satélites.

–El GPS diferencial (DGPS) disminuye en gran medida 
los errores atmosféricos y orbitales, y contrarresta las 
señales anti-spoofing que el Departamento de Defensa 
de los Estados Unidos transmite con las señales GPS.

–Mientras mayor sea la cantidad de satélites visibles, 
más fuerte será la señal, y menor el valor de DOP, y se 
obtendrá un posicionamiento más preciso.

• Disponibilidad – La disponibilidad de los satélites 
afecta el cálculo de las posiciones válidas. Mientras 
mayor sea la cantidad de satélites disponibles, más 
valida y precisa será la posición. Los objetos naturales 
y aquellos creados por el hombre pueden bloquear, 
interrumpir y debilitar las señales, disminuyendo la 
cantidad de satélites disponibles.

• Integridad – La tolerancia a las fallas permite a una 
posición tener mayor integridad, mejorando la 
precisión. Diversos factores se combinan para ofrecer 
una tolerancia a las fallas, entre los que se incluyen:

–El Monitoreo Autónomo de la Integridad del Receptor 
(RAIM) detecta satélites GPS y GLONASS 
defectuosos y los elimina del cálculo de la posición.
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–El sistema WAAS (Wide Area Augmentation System 
o Sistema de corrección de señales GPS) crea y 
transmite mensajes de corrección DGPS.

–Cinco o más satélites visibles sólo para GPS o sólo 
para GLONASS; seis o más satélites para escenarios 
mixtos.

–Efemérides y almanaques actuales.

–Varios algoritmos para detectar y corregir 
información defectuosa.

Conclusión

Los topógrafos pueden utilizar receptores GPS+ de Topcon 
para colectar datos de una red de satélites y estaciones de 
control para triangular puntos precisos en cualquier lugar 
de la tierra.

Esta descripción general sencillamente explica los 
conceptos básicos del posicionamiento GPS y GLONASS. 
Para obtener información más detallada, visite el sitio web 
de TPS (www.topconps.com/gpstutorial/).

Descripción General del Receptor
Una vez encendido el receptor y que se ha completado la 
prueba automática, los 40 canales del receptor se inicializan y 
empiezan a rastrear satélites GPS y GLONASS visibles. Cada 
uno de los canales del receptor puede utilizarse para rastrear 
señales C/A-L1, P-L2 o P-L2. El número de canales 
disponibles permite al receptor rastrear simultáneamente todos 
los satélites GPS y GLONASS visibles en cualquier momento y 
ubicación. La antena GPS y GLONASS combinada (GPS+) 
recibe las diferentes señales y las procesa.

Una antena GPS+ equipada con un dispositivo amplificador 
opcional de bajo ruido (LNA) y la radio frecuencia (RF) del 
receptor se conectan con un cable coaxial. La señal de banda 
Topcon Manual de Instrucciones del HiPer+
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ancha recibida es convertida, filtrada, digitalizada y asignada a 
canales diferentes. El procesador del receptor controla el 
proceso de rastreo de la señal.

Una vez que el canal capta la señal, la demodula y se miden los 
parámetros de señal necesarios (portadora y fases de código). 
Asimismo, los datos de navegación transmitidos son 
recuperados de la página de navegación.

Una vez que el receptor capta cuatro o más satélites, es posible 
resolver el problema denominado “problema de 
posicionamiento absoluto” y calcular las coordenadas del 
receptor y el tiempo (en WGS-84). Toda esta información se 
almacena en la memoria del receptor, que puede descargarse 
después a una computadora y procesarse utilizando un paquete 
de software de post-procesamiento. Cuando el receptor 
funciona en el modo RTK, las mediciones de datos sin procesar 
también pueden registrarse en la memoria interna del receptor. 
Esto le permite al operador verificar doblemente los resultados 
en tiempo real obtenidos en el campo.

Las capacidades del receptor HiPer+ incluyen:

• Rastreo Co-Op

• Reducción multipath

• Sistema WAAS

• Circuitos ajustables de enganche de fase (PLL) y 
parámetros de bucle de captura de retardo (DLL).

• Modos de levantamiento estático de doble frecuencia, 
cinemático, cinemático en tiempo real (RTK) y GPS 
diferencial.

• Registro automático de datos

• Establecer diferentes ángulos de máscara

• Establecer diferentes parámetros de levantamiento

• Modo estático y dinámico
P/N 7010-0526-SP www.topconpositioning.com
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Contenido del Paquete Estándar
El HiPer+ incluye un paquete cinemático en tiempo real (RTK) 
común con un Legacy-E como Estación Base y el HiPer+ como 
Rover (consulte también las instrucciones de re-embalaje). Este 
paquete incluye:

• HiPer+

• Receptor GPS Legacy-E

• Antena micro-centrada de precisión PG-A1

• Juego de radio base UHF

• LitePole

• Trípode, base nivelante, y adaptador

• Software Pinnacle o Topcon Tools

• Cables y cordones

• Documentación

Cables
Los cables del paquete estándar incluyen:

• Cable serial RS232 receptor a computadora

• Cable de energía receptor a SAE

• Extensión del cable SAE a SAE

• Pinzas de cocodrilo al cable SAE

• Cable de alimentación / cargador

• Conector SAFECO W/48” de alimentación

Software
El software estándar del HiPer+ incluye:

• PC-CDU – software controlador que puede correr en una 
computadora basada en Windows®. Por favor consulte el 
Topcon Manual de Instrucciones del HiPer+



Contenido del Paquete Estándar

1-9
Manual del Usuario PC-CDU para obtener información 
detallada sobre este software.

• Software de configuración de radio GPS – software de 
terceros como PDLCONF de Pacific Crest.

• Topcon Tools – Software de post-procesamiento de 
Topcon.

Puede encontrar el software e información sobre el software en 
el sitio web de Topcon (www.topcongps.com/software/
index.html o http://www.topcongps.com/software/
3rdparty.html).

Los siguientes software también serán útiles para operar, cuidar 
y utilizar su receptor HiPer+, y podría requerirse para algunas 
aplicaciones.

• FLoader – Cargador de firmware de Topcon; disponible en 
el sitio web de Topcon.

• PDLCONF de Pacific Crest – programa de configuración 
de radio incluido con el paquete de la Estación Base; 
actualizaciones de firmware disponibles del sitio web de 
Pacific Crest (www.paccrst.com/download/upgrade.htm).

• BTCONF – Programa de configuración del módulo 
Bluetooth de Topcon; disponible en el sitio web de Topcon.

• TopSURV – Software de colección de datos de campo de 
Topcon, que entre otras diversas funciones, puede utilizarse 
para configurar el radio/módem.

• Survey Pro GPS – Software opcional de terceros útil para la 
colección y visualización de datos; contáctese con su 
distribuidor TPS.

• Carlson SurvCE – Software opcional de terceros para 
recolección de datos, contáctese con su distribuidor TPS.
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Documentación
La documentación del HiPer+ incluye:

• Tarjeta de garantía de un año

• Manual de Instrucciones del HiPer+

• Especificaciones funcionales

• Tarjeta de instrucciones de empaquetamiento

Los manuales y la información relacionada con los productos 
también están disponibles en el sitio web de Topcon—
www.topcongps.com/hardware/index.html (después haga clic 
en el producto apropiado).

Los siguientes manuales también son útiles para operar y cuidar 
su receptor HiPer+. Estos manuales están disponibles en el sitio 
web de Topcon (www.topcongps.com/support/manuals.html).

• Manual de Usuario del PC-CDU

• Manual de Usuario del FLoader

• Manual de Usuario de la MINTER

Conociendo su Equipo
El HiPer+ tiene 158.5mm de ancho, 173mm de profundidad, 
113mm de altura y pesa 1.72kg. El diseño avanzado del receptor 
permite a los usuarios reducir el número de cables requeridos para 
la operación del receptor, permitiendo al usuario efectuar trabajos 
con más confiabilidad y eficiencia, especialmente cuando el 
receptor se encuentra en movimiento.

El HiPer+ también es versátil y es posible configurarlo de diversas 
formas. La carcasa tiene espacio para dos baterías de Litio-Ion no 
removibles incorporadas, un módulo de tecnología inalámbrica 

Bluetooth™1, y dos tarjetas Euro. Una de estas tarjetas es el 

1. Bluetooth es una marca registrada de Bluetooth SIG, Inc. y es 
utilizada por Topcon Positioning Systems, Inc. bajo licencia.
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receptor GPS+ y el otro se utiliza para comunicaciones (módem, 
amplio espectro, GSM, o DGPS). 

El HiPer+ presenta los mismos componentes estándar interiores de 
cualquier receptor y dos paneles para la interfaz del usuario, 
comunicación y alimentación. Para obtener las especificaciones del 
HiPer+, revise el Apéndice B.

Componentes Internos
Las características del HiPer+ incluyen:

Antena GPS+ 

Antena de microstrip interna capaz de recibir señales GPS 
L1/L2 y GLONASS L1/L2.

Módulo Bluetooth

Una combinación de tecnología de software y hardware 
que hace del HiPer+ un receptor GPS+ inalámbrico y móvil 
que soporta un perfil serial punto a punto. Como tal, el 
HiPer+ puede transferir y sincronizar archivos entre el 
receptor y cualquier otro dispositivo de tecnología 
inalámbrica Bluetooth que soporta el perfil serial, 
incluyendo dispositivos handheld portátiles y controladores 
externos, adaptadores PC-USB/RS, computadoras y 
teléfonos móviles, IPAQs, adaptadores PCMA a Bluetooth, 
etc.

Con la tecnología inalámbrica Bluetooth, la recepción y 
distancia de transmisión de HiPer+ es de 10 metros (32 
pies) para proyectos en interiores y 30 a 50 metros (98 a 
164 pies) para proyectos exteriores.

El procesador y firmware del módulo Bluetooth son 
independientes de la tarjeta del receptor y tablero de 
energía.
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Radio Módem

El HiPer+ incorpora un módem interno para recibir datos 
desde una estación Base. El módem de la estación base 
transmite la fase de portadora y mediciones de código junto 
con la información de la estación de referencia (es decir, 
ubicación y descripción) al módem del rover.

Su HiPer+ podría incluir una de las siguientes tarjetas de 
comunicación (sin embargo, su receptor también puede 
configurarse sin un radio/módem):

• Módem UHF – un módem (Positioning Data Link) 
PDL de Pacific Crest; de 450–470 MHz o 430–450 
MHz; sólo recepción.

• Amplio Espectro – un módem de 915 MHz o 2.4 GHz.

• GSM – Módem de frecuencia de teléfono celular de 
doble banda para dos usuarios (Europa y Japón: 900/
1800 MHz; Estados Unidos y Canadá: 900/1900 MHz).

• Receptor de datos de transmisión – Tarjeta de 
comunicación TPS-BDR para recibir correcciones 
diferenciales de radio faros DGPS satélites banda L 
geoestacionarios que transmiten datos OmniStar® data.

Es responsabilidad del operador de la estación Base debe 
cumplir con las regulaciones locales para la operación de 
radios. En los Estados Unidos, la FCC regula el uso de 
radiotransmisores, y exige una licencia. Transmitir sin una 
licencia puede traer como consecuencia penalidades 
severas que incluyen incluso la confiscación de su radio y 
equipo GPS+. Por favor llame al Servicio de Soporte al 
Cliente de TPS en caso necesite orientación con respecto a 
la obtención de la licencia correcta en los Estados Unidos.

El radio módem PDL interno incluye una serie de 
frecuencias preconfiguradas que han sido programadas en 
Topcon.
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ADVERTENCIA
El uso de estas frecuencias preconfiguradas 
sin contar con una licencia es ilegal. 
Contáctese con las autoridades locales (la 
FCC en los Estados Unidos) para utilizar 
estas frecuencias preconfiguradas

Una vez que la FCC, o su autoridad local emita las 
licencias adecuadas, su distribuidor TPS programará sus 
radios PDL (Base y Rover) para habilitar las 
comunicaciones.

También es posible encontrar información completa con 
respecto a su sistema de radio en los manuales de radio de 
Pacific Crest.

Tablero de Energía

El tablero interno de energía gestiona la energía del 
receptor y la carga de baterías y se conecta a la tarjeta del 
receptor y a las baterías. El tablero de energía recibe 
energía de las baterías internas, incluso cuando el receptor 
está apagado. Esta característica permite que las baterías 
internas se carguen, independientemente del estado del 
receptor (encendido o apagado). Para evitar que las baterías 
se descarguen cuando el receptor permanece guardado, 
ponga el receptor en el Modo Energía Cero (vea “Modo 
Energía Cero ” en la página 4-23 para obtener más 
información). Las baterías no se cargarán en este modo.

El procesador y el firmware de la tarjeta de energía son 
independientes de la tarjeta del receptor. Para asegurar la 
compatibilidad del firmware, será necesario cargar la 
tarjeta del receptor GPS y la tarjeta de energía con el 
firmware del mismo paquete.
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Tarjeta del Receptor GPS

El HiPer+ incluye la tarjeta Euro-112 que es capaz de 
procesar las señales GPS L1/L2 y GLONASS L1/L2.

La Tarjeta Euro enumera las opciones disponibles para esta 
tarjeta.

Un receptor TPS con WAAS permite el rastreo simultáneo 
de dos satélites WAAS. Cada uno de los satélites WAAS se 
ubica en su propio canal.

Baterías

El receptor HiPer+ incluye paquetes de baterías 
incorporadas no removibles recargables conectadas al 
tablero de energía del receptor. Cada uno de estos paquetes 
de baterías de litio-ion tiene 7.4 V y 3 Ah, ofreciéndole una 
potencia total de 7.4 V nominal y 6 Ah si se encuentra 
totalmente cargada.

Con una carga completa, las baterías internas deben 
alimentar tanto el receptor GPS como el radio módem PDL 
durante al menos 11.5 horas de trabajo. Si el radio módem 
interno está apagado, el receptor GPS debe funcionar al 
menos 13.5 horas con baterías internas totalmente 
cargadas.

Las baterías de Litio-Ion utilizadas en el HiPer+ deben 
funcionar a no menos del 98% después de 500 ciclos de 
carga. Estas baterías no necesitan descargarse totalmente 
antes de volver a cargarse.

Tabla 1-1. Opciones de la Tarjeta Euro

Modelo de la Tarjeta Euro Opciones Disponibles

Euro-112 (HE_GGD) G: GPS L1
GD: GPS L1/L2
GG: GPS/GLONASS L1
GGD: GPS/GLONASS L1/L2
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El paquete estándar incluye un cargador de baterías 
(Adaptador AC). Vea el Apéndice B para obtener las 
especificaciones técnicas de la batería.

Componentes Externos
La carcasa del HiPer+ incluye un conector para colocar la 
antena del módem, una interfaz de usuario, un puerto de 
energía y puertos para configuración.

Radomo

Figura 1-2 muestra los componentes radomo.

Figura 1-2. Radomo del HiPer+

• Antena interna – Ubicación de la antena interna GPS/
GLONASS.

• Conector de la antena del módem – El conector de la 
antena del módem se utiliza para la conexión RF del 
módem interno. Este es un conector hembra BNC para 
los módems de Pacific Crest PDL (UHF) o un conector 
hembra TNC para los módems de espectro amplio y 
GSM.
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Panel Inferior

• Número de serie del receptor

• Número de parte del receptor

• Punto de Referencia de la Antena (ARP)

Panel Frontal 

Figura 1-3 muestra los componentes del panel frontal.

Figura 1-3. Panel Frontal del HiPer+

• MINTER – La INTERfaz Mínima para el receptor 
HiPer+. La MINTER está formada por dos teclas y 
cuatro LEDs de tres colores. Vea Capítulo 4 en la 
página 4-2 para obtener información sobre las 
descripciones y usos de los componentes de la 
MINTER.

• Reiniciar – Al presionar esta tecla se efectúa un reinicio 
completo tanto para la tarjeta del receptor como para la 
tarjeta de energía. Una vez que se presiona esta tecla, 
los controladores que regulan la tarjeta del receptor, la 
tarjeta de energía y el módulo Bluetooth se reinicia y el 
dispositivo vuelve a arrancar.

A B C D

USB PowerReset

MINTER
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Esta tecla puede utilizarse para salir del Modo Cero 
Energía o si el receptor no responde a los comandos. 
Vea Capítulo 4 en la página 4-2 para obtener detalles.

• Cuatro puertos seriales:

–El puerto A se utiliza para la comunicación entre el 
HiPer+ y un controlador u otro dispositivo externo.

–El puerto B se utiliza internamente para conectar la 
tarjeta del receptor con el módulo Bluetooth.

AVISO
Si cambia las configuraciones por defecto del 
Puerto B el enlace Bluetooth se verá afectado. 
Las configuraciones por defecto para el Puerto 
B son: 115200 bps, 8 bits de datos, 1 bit de 
parada, sin paridad, y sin negociación.

–El Puerto C se utiliza internamente para conectar los 
tableros del módem y del receptor.

–El Puerto D se utiliza para la comunicación entre el 
receptor y un dispositivo externo

• PWR – Es el puerto de entrada de energía al cual se 
encuentra conectada la fuente externa de energía (+6 A 
+28 V DC) y donde se carga la unidad.

• USB – Utilizado para la transferencia y comunicación 
de datos a alta velocidad entre el receptor y un 
dispositivo externo.

• Marca de medición de altura inclinada (SHMM)
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Panel Posterior

Figura 1-4 muestra los componentes del panel posterior.

Figura 1-4. Panel Posterior del HiPer+

• Tapón de ventilación – Equilibra la presión entre la 
parte interna del receptor y el medio exterior.

• Marca de medición de altura inclinada (SHMM)

Archivo de Opciones Autorizadas 
(OAF)
Topcon Positioning Systems emite un Archivo Autorizado de 
Opciones (OAF, por sus siglas en inglés) para habilitar las opciones 
específicas adquiridas por el cliente. Un Archivo Autorizado de 
Opciones permite a los clientes personalizar y configurar el HiPer+ 
de acuerdo con sus necesidades particulares. El objetivo de este 
archivo es que el cliente adquiera únicamente las opciones que 
necesita.

Generalmente, todos los receptores HiPer+ incluyen un OAF 
temporal que permite utilizar el receptor durante un período 
determinado de tiempo. Al comprar el receptor, un nuevo OAF 
activa las opciones deseadas y compradas de manera permanente. 
Las opciones del receptor permanecen intactas al clearing la 
NVRAM o reinicializar el receptor.

Slant Height Measure Mark

Vent Plug
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El OAF habilita los siguientes tipos de funciones. Para una lista 
completa de opciones y detalles disponibles, visite el sitio web de 
TPS (www.topcongps.com/tech/index) o consulte a su 
distribuidor TPS.

• Tipo de señal (estándar L1; opcional L2)

• Memoria (estándar 0MB; opcional 1MB hasta 1GB)

• Velocidad estándar de actualización 1 Hz (opcional 5, 10 o 20 
Hz)

• RTK at 1Hz, 5Hz, 10Hz, y 20Hz

• Entrada /Salida RTCM/CMR

• Marcador de Eventos

• Rastreo Co-Op

• Mitigación avanzada multipath

• Sistema WAAS

• Monitoreo Autónomo de la Integridad del Receptor (RAIM)

• 1 PPS (Pulso por Segundo, señal de sincronización)
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Apuntes:
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El presente capítulo describe:

• Fuente de alimentación del HiPer+

• Conectar el receptor y una computadora

• Configuración del HiPer+

• Configuración de la INTERfaz Mínima (MINTER) 

• Configuración del radio

• Configuración del módulo Bluetooth

• Colectar almanaques

Antes de utilizar su receptor HiPer+, debe:

1. Cargar las baterías. Vea “Cargar el HiPer+” en la página 2-2.

2. Configurar las diversas partes de su receptor. Vea:

• “Conectar el HiPer+ a una Computadora” en la página 2-5,

• “Configuración del HiPer+” en la página 2-11,

• “Configuración de la MINTER” en la página 2-24, 

• “Configuración del Radio” en la página 2-33 (en caso de 
ser aplicable), y

• “Configuración del Módulo Bluetooth” en la página 2-46.

3. Colectar un almanaque. Vea “Colectando Almanaques” en la 
página 2-52.
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Cargar el HiPer+
Usted puede cargar el HiPer+ usando:

• Baterías internas

• Baterías externas

• Un cargador de baterías

Baterías Internas
Con una carga completa, las baterías internas del HiPer+ deben 
alimentar tanto al receptor GPS como al módulo Bluetooth, así 
como al radio módem PDL durante un mínimo de 11.5 horas de 
trabajo. Si el radio módem interno está apagado, el receptor 
GPS HiPer+ debe funcionar al menos durante 13.5 horas con 
las baterías internas totalmente cargadas.

1. Conecte el cable de energía/cargador en el puerto de 
entrada de energía.

2. Conecte el cable de energía/del cargador en un 
tomacorriente disponible.

PRECAUCIÓN
Utilice un tomacorriente con conexión a 
tierra.

3. Presione la tecla Reset (Inicialización) en el receptor para 
asegurarse que el receptor se encuentre en el modo Normal 
para la carga. El receptor no se cargará en el Modo Energía 
Cero (vea “Modo Energía Cero ” en la página 4-23 para 
obtener más información).

4. Cargue el receptor toda la noche. Una carga de seis horas 
cargará las baterías en aproximadamente 90%. Con una 
carga de siete horas cargará, el receptor estará totalmente 
cargado. Las baterías internas no pueden sobrecargarse.
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La velocidad de la carga depende de las configuraciones de 
Alimentación y del Cargador de la pantalla de Configuración 
del Receptor PC-CDU, y de si el receptor se encuentra 
encendido o apagado. Vea “Gestión de la Energía” en la 
página 2-16 para obtener más información sobre estas 
configuraciones.

Las baterías de Litio-Ion que utiliza HiPer+ deben funcionar a 
no menos del 98% de su capacidad después de 500 ciclos de 
carga. Estas baterías no necesitan descargarse antes de ser 
recargadas.

Baterías Externas
Además de las baterías internas, es posible utilizar su HiPer+ 
con baterías externas. El uso de baterías externas le permite 
continuar utilizando el receptor en caso que las baterías internas 
se descarguen. Para utilizar las baterías externas, usted debe 
tener:

• Una batería de 12 V, 2.3 A*h 

• Una pinza para baterías 2.3 A*h conectada al conector SAE

• Un conector SAE para el cable del tomacorrientes 

AVISO
En caso que el receptor se encuentre utilizando 
baterías externas, asegúrese que el modo 
cargador esté configurado en Off. De lo 
contrario, las baterías externas también 
cargarán las baterías internas, Vea “Gestión de 
la Energía” en la página 2-16 de la Energía para 
obtener más información sobre la configuración 
del modo cargador.
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1. Conecte dos cables utilizando conectores SAE.

2. Enchufe el cable de alimentación en el puerto de 
alimentación del HiPer+.

3. Conecte la pinza para baterías a la batería. Una sola batería 
externa de 12 V, 2.3 A*h debe alimentar al HiPer+ durante 
aproximadamente 7 horas y al HiPer+ y al módem durante 
no menos de 5 horas. 

PUNTA
También puede utilizar un cable de extensión 
SAE a SAE y una pinza tipo cocodrilo al cable 
SAE, y cargue su HiPer+ directamente desde 
una batería, como por ejemplo la batería 
utilizada para alimentar su radio Base o una 
batería similar. 

Cargador de Batería
El mismo cargador utilizado para cargar las baterías internas 
puede utilizarse como fuente externa de alimentación para el 
receptor HiPer+. El cargador viene con el paquete del receptor.

1. Conecte el cargador de baterías al puerto de energía del 
panel frontal del HiPer+.

2. Conecte el cargador en una toma de 110/220 V. La entrada 
de energía para su cargador de batería debe ser AC entre 90 
y 264 V 1A (110 V AC) y entre 47 Hz y 63 Hz. El cargador 
de baterías genera DC 12 V 2.5 A (30 W).
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Encender/Apagar el HiPer+
Para encender el receptor, presione la tecla verde de encendido 
durante aproximadamente 0.5 segundos y suéltela.

AVISO
Si el receptor no se enciende, podría estar en el 
Modo Energía Cero. Vea ““Modo Energía Cero ” 
en la página 4-23 para obtener más información.

Para apagar el receptor, presione la tecla verde de encendido 
durante más de uno y menos de cuatro segundos (hasta que 
ambos LEDs, el de ESTADO y el de REGISTRO estén 
apagados). Este retardo (de aproximadamente 1 segundo) 
evitará que el usuario apague el receptor por error.

Conectar el HiPer+ a una Computadora
Para configurar, administrar archivos o hacerle un mantenimiento al 
HiPer+, debe conectar el receptor a una computadora utilizando:

• El HiPer+, un dispositivo externo con Bluetooth (computadora) 
y PC-CDU.

O

•  El HiPer+, un cable RS232, una computadora, y PC-CDU.

O

• El HiPer+, un cable USB, una computadora con el driver USB 
de TPS instalado y el PC-CDU.

Una vez que ha establecido una conexión entre el receptor y la 
computadora (ya sea a través de la tecnología inalámbrica 
Bluetooth, el cable RS232, o el cable USB), usted podrá:

• Configurar el receptor y sus componentes

• Enviar commandos al receptor

• Descargar archivos desde la memoria del receptor
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• Cargar un nuevo firmware, OAFs, y archivos de configuración 
al receptor

Establecer una Conexión Inalámbrica
El receptor HiPer+ contiene tecnología inalámbrica Bluetooth 
que permite la transferencia de archivos y la sincronización 
entre el receptor y cualquier otro dispositivo externo que 
soporte la tecnología inalámbrica Bluetooth; por ejemplo, un 
IPAQ, o una computadora con un adaptador USB a Bluetooth o 
un adaptador PCMA a Bluetooth instalados.

AVISO
Cambiar las configuraciones por defecto del 
Puerto B del receptor afectará el enlace 
Bluetooth. Los valores por defecto para el Puerto 
B son: 115200 bps, 8 bits de datos, 1 bit de 
parada, sin paridad y sin negociación.

El HiPer+ y el procedimiento de conexión de dispositivos 
externos varían ligeramente dependiendo del tipo de dispositivo 
externo utilizado. De manera general, el procedimiento de 
conexión es el siguiente:

AVISO
Consulte la documentación del dispositivo 
externo en el que ha configurado el Bluetooth 
para obtener información de conexión más 
detallada.

1. Encienda el dispositivo externo habilitado con el Bluetooth 
y su receptor. El modo del dispositivo externo por defecto 
es Master; el modo el módulo Bluetooth es Slave.

2. Haga que el dispositivo externo (Master) busque el receptor 
(Slave).
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3. Una vez que el dispositivo Master detecta el receptor, 
utilice el procedimiento descrito en la documentación del 
dispositivo externo para conectarlo con el receptor.

4. Una vez conectado, continúe con el Paso 1 en “Establecer 
una Conexión PC-CDU” en la página 2-8.

Si no puede establecer una conexión, verifique que el slot 3 del 
receptor se encuentre habilitado.

1. Conecte su receptor y una computadora utilizando un cable 
RS232 (vea “Establecer una Conexión con un Cable 
RS232” en la página 2-7).

2. Haga clic en Configuration->Receiver->General.

3. En el área Encender/Apagar Slots, asegúrese que la casilla 
de verificación del Slot 3 (B) se encuentre habilitada.

Establecer una Conexión con un Cable 
RS232
1. Con el cable RS232, conecte el puerto serial de su 

computadora (generalmente COM1) al puerto de serie A 
del receptor.

2. Presione los botones de encendido del receptor y de la 
computadora para encenderlos.

3. Continúe con el Paso 1 en “Establecer una Conexión PC-
CDU” en la página 2-8.

Establecer una Conexión con un Cable 
USB
Asegúrese de haber instalado un driver USB de Topcon 
(disponible en http://www.topcongps.com/software/
updates.html) antes de continuar.

1. Con el cable USB, conecte el puerto USB del receptor a un 
puerto USB en la computadora.
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2. Presione los botones de encendido en el receptor y en la 
computadora para encenderlos.

3. Continúe con el Paso1 en “Establecer una Conexión PC-
CDU” en la página 2-8.

Establecer una Conexión PC-CDU
PC-CDU es un software de Unidad de Pantalla de Control para 
Computadoras Personales que se utiliza para gestionar las 
diversas funciones de su receptor. La gama completa de 
configuraciones y funciones del PC-CDU se encuentra fuera 
del alcance del presente manual. Para obtener más información 
sobre los procedimientos a los que se hace mención en esta 
sección o en el PC-CDU, consulte el Manual de Usuario del 
PC-CDU disponible en el sitio web de TPS.

1. Una vez que el receptor y la computadora se encuentren 
conectados, inicie el PC-CDU en su computadora. Ahora 
verá la pantalla principal del PC-CDU (Figura 2-1).

Figura 2-1. Pantalla Principal del PC-CDU

Observe que la esquina inferior izquierda muestra el estado 
del receptor como “Disconnected” (Desconectado).
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2. Haga clic en File->Connect (Figura 2-2).

Figura 2-2. Hacer clic en File->Connect

3. En el cuadro de diálogo Connection Parameters 
(Parámetros de Conexión), seleccione los siguientes 
parámetros para las conexiones Bluetooth o RS232 y haga 
clic en Connect (Figura 2-3):

• Defina el modo de Conexión (Directo).

• Defina el puerto para su computadora (generalmente 
COM1) en la lista desplegable Port.

• Defina la velocidad de conexión entre el receptor y la 
computadora (generalmente 115200) en la lista 
desplegable de velocidad de transferencia en baudios.

Figura 2-3. Parámetros de Conexión del Bluetooth y de RS232 

O

Seleccione los siguientes parámetros para las conexiones 
USB (Figura 2-4) y haga clic en Connect:
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• Defina el modo de Conexión (Directo).

• Defina el puerto para su computadora (USB) de la lista 
desplegable Port.

• Seleccione el ID del receptor de la lista desplegable 
Rec ID.

Figura 2-4. Parámetros de Conexión USB

Una vez que se ha establecido una conexión PC-CDU con el 
receptor, los valores de comunicación actuales, tales como 
nombre del puerto, velocidad de transferencia en baudios (si 
corresponde), y control de flujo (si corresponde), aparecen en la 
esquina inferior izquierda de la ventana principal del PC-CDU.   
Asimismo, se inicia un temporizador en la esquina inferior 
derecha (Figura 2-5).

Figura 2-5. Conexión Establecida del PC-CDU
Topcon Manual de Instrucciones del HiPer+



Configuración del HiPer+

2-11
Configuración del HiPer+
Utilice el software PC-CDU para configurar las diversas partes del 
receptor HiPer+. Todos los valores que establezca utilizando el 
software PC-CDI se guardarán en la memoria del receptor y estos 
cambios serán evidentes al usar la MINTER. La gama completa de 
configuraciones y funciones del software PC-CDU se encuentra 
fuera del alcance de este manual.

PUNTA
Consulte el Manual del Usuario del software 
PC-CDU para conocer todas las configuraciones 
posibles del receptor HiPer+.

La siguiente configuración se recomienda para la mayoría de 
aplicaciones comunes. Sin embargo, podrá seleccionar los 
parámetros que necesite para su trabajo.

AVISO
Haga clic en Apply después de hacer cualquier 
cambio en la configuración, en caso contrario su 
receptor no aceptará el cambio.

1. Conecte su receptor y computadora. Vea “Conectar el HiPer+ a 
una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.

2. Una vez conectado, haga clic en Configuration->Receiver 
(Figura 2-6).

Figura 2-6. Configuration->Receiver
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Aparecerá el cuadro de diálogo Receiver Configuration 
(Figura 2-7).

Figura 2-7. Configuración del Receptor

3. Haga clic en la pestaña MINTER, configure los siguientes 
valores y después haga clic en Apply (Figura 2-8 en la 
página 2-13).

• Defina el intervalo de Registro en segundos.

• Defina la máscara de Elevación para el archivo de Registro 
en grados.

• Ingrese el prefijo del nombre de Archivo. Utilice los tres 
últimos dígitos del número de serie de su receptor. Usted 
puede encontrar el número de serie y el número de parte del 
receptor en el panel inferior del receptor.
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Figura 2-8. Configuración del Receptor – Pestaña MINTER

Si su obra se encuentra en un área que presenta obstrucciones 
(edificios, árboles etc.), y/o la ubicación de la antena se encuentra 
cerca de objetos reflexivos, configure el receptor para reducir los 
errores de estas fuentes.

ADVERTENCIA
No haga otros cambios sin consultar el 
Manual del Usuario del software PC-CDU.
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4. Haga clic en la pestaña Advance en la pantalla de 
Configuración del Receptor (Figura 2-9).

Figura 2-9. Configuración del Receptor – Pestaña Advanced 

5. Haga clic en la pestaña Multipath Reduction, habilite las 
siguientes casillas y haga clic en Apply (Figura 2-10).

• Reducción multipath de código

• Reducción multipath de portadora

Figura 2-10. Configuración Avanzada – Multipath Reduction
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6. Haga clic en la pestaña Loop Management (Gestión de Bucle), 
habilite las siguientes casillas y haga clic en Apply 
(Figura 2-11).

• Habilite el rastreo Co-Op

• Modo estático

Figura 2-11. Configuración Avanzada – Loop Management

7. Haga clic en OK para cerrar la pantalla de Configuración del 
Receptor.

8. Haga clic en File->Disconnect, después en File->Exit para 
salir del PC-CDU (Figura 2-12).

Figura 2-12. Hacer clic en Disconnect y después en Exit
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AVISO
Desconectar el receptor desde la computadora 
antes de salir eliminará cualquier posible 
conflicto en la gestión de sus puertos seriales.

Una vez que ha configurado el receptor, la configuración será válida 
hasta que la cambie nuevamente utilizando el software PC-CDU o 
borrando la NVRAM.

Gestión de la Energía
Usted puede utilizar el software PC-CDU para gestionar la 
energía de su receptor. La descripción completa del software 
PC-CDU se encuentra fuera del alcance del presente manual, 
pero puede encontrarla en el Manual del Usuario del PC-CDU. 
Puede descargar la copia más reciente de este software y el 
manual en el sitio web de TPS.

Para acceder a la pestaña que controla los valores de energía de 
su receptor, siga los siguientes pasos: 

1. Conecte su receptor y computadora. Vea “Conectar el 
HiPer+ a una Computadora” en la página 2-5 para obtener 
información sobre este procedimiento.

2. Una vez conectado, haga clic en Configuration->Receiver 
(Figura 2-13).

Figura 2-13. Configuration->Receiver
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3. Seleccione la lista desplegable Power Mode (Modo de 
Energía) para configurar la fuente de energía deseada 
(Figura 2-14). Current Mode (Modo Actual) despliega la 
fuente actual de energía.

Figura 2-14. Seleccionar Modo de Energía

• Auto – el receptor automáticamente seleccionará la 
fuente de energía.

• Mix – el receptor automáticamente detectará y 
empezará a consumir energía de la fuente con mayor 
voltaje.

• Battery A – el receptor consumirá energía de la batería 
A.

• Battery B – el receptor consumirá energía de la batería 
B.

• External – el receptor utilizará una fuente de 
alimentación externa.
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4. Seleccione la lista desplegable Charger Mode (Modo del 
Cargador) para definir el modo de carga deseado 
(Figura 2-15). Current Mode (Modo Actual) indica la 
batería de carga: a, b, o none (off) (ninguna) (apagado).

Figura 2-15. Seleccionar Modo del Cargador

• Off – El receptor no cargará baterías.

• Charge A – el receptor sólo cargará la batería A.

• Charge B – el receptor solo cargará la batería B.

• Auto – el receptor automáticamente detectará y cargará 
ambas baterías.
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5. Seleccione la lista desplegable Ports de Power output 
modes (Modos de salida de energía) (Figura 2-16).

Figura 2-16. Seleccionar Modos de Salida de Energía– Puertos

• On – el tablero de energía alimentará al pin uno de 
todos los conectores de los puertos de serie cuando el 
receptor se encuentre encendido. Si el receptor está 
apagado, no habrá energía en ninguno de los puertos.

• Off – no habrá energía incluso cuando el receptor se 
encuentre encendido.

• Always – el tablero de energía alimentará con voltaje al 
pin uno de todos los conectores de los puertos de serie 
incluso si el receptor se encuentra apagado.
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6. Seleccione los Power output modes (Modos de salida de 
energía) de la lista desplegable Slots para definir la salida 
de energía en los slots internos (Figura 2-17).

Figura 2-17. Seleccionar Modos de Salida de Energía – Slots 

• On – todos los slots serán alimentados si el receptor se 
encuentra encendido.

• Off – los slots internos no serán alimentados incluso si 
el receptor se encuentra encendido.

• Always – los slots internos serán alimentados incluso si 
el receptor se encuentra apagado.
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7. Ver Información sobre Voltajes (Figura 2-18).

Figura 2-18. Ver Información sobre Voltaje

• External – muestra el voltaje de la fuente de 
alimentación externa.

• On Board – muestra el voltaje consumido por el tablero 
del receptor.

• Battery A – muestra el voltaje de la batería A.

• Battery B – muestra el voltaje de la batería B.

• Charger – despliega el voltaje de salida del cargador 
durante la carga de la batería.

8. Seleccione y habilite cada una de las casillas de 
verificación de Turn on/off Slots para habilitar los slots 
internos correspondientes (Figura 2-19 en la página 2-22).
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9. Seleccione y habilite la casilla de verificación  Enable Low 
Power Mode para que el procesador del receptor pase al 
modo de bajo consumo de energía (Figura 2-19).

Figura 2-19. Habilitar y Aplicar los Valores de Energía

10. Haga clic en Apply.

Cargar las Baterías Internas

Utilice una de las siguientes condiciones para obtener la 
velocidad máxima de carga de batería.

• El receptor se encuentra apagado. Power Mode se 
configura en External y Charger Mode en Auto. Vea 
“Gestión de la Energía” en la página 2-16 para 
configurar estos parámetros.

• El receptor se encuentra encendido. El Power Mode se 
configura en External y el Charger Mode en Auto.

1. Conecte el cable de energía/cargador en el puerto de 
entrada de energía.

2. Conecte el cable de energía/cargador en un 
tomacorriente disponible.

3. Presione la tecla Reset en el receptor. Al hacerlo se 
asegurará que el receptor se encuentre en modo Normal 
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para cargar. El receptor no se cargará en el Modo 
Energía Cero (vea “Modo Energía Cero ” en la 
página 4-23 para obtener más información).

4. Deje cargar durante la noche. Una carga de seis horas 
cargará la batería en aproximadamente un 90%. Una 
carga de siete horas cargará totalmente el receptor. Las 
baterías internas no pueden sobrecargarse.

5. Al terminar de cargar, defina Power Mode a Auto.

AVISO
Si retira un cable de alimentación antes de 
definir Power Mode a Auto, el receptor se 
apagará. Para encenderlo, tendrá que conectar 
una fuente de alimentación externa una vez 
más.

Verificar el Estado de la Batería Interna

Tiene tres opciones para verificar el estado de las baterías 
internas:

1. Visualice el LED de la batería. Vea “LED de la Batería” 
en la página 4-7 para obtener más información sobre 
este LED.

• Una luz verde indica una carga de más del 85%.

• Una luz naranja indica una carga intermedia.

• Una luz roja indica una carga de menos del 15%.

2. Haga clic en Configuration->Receiver y visualice los 
voltajes de la batería en la pantalla de Configuración 
del Receptor.

O 

Haga clic en Help->About y visualice los voltajes de la 
batería en la pantalla About PC-CDU.
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Configuración de la MINTER
La INTERFAZ Mínima (MINTER) del HiPer+ está formada por 
dos teclas (Encendido y FN) y cuatro LEDs (ESTADO, 
REGISTRO, BATERÍA, y MÓDEM) (Figura 2-20).

Figura 2-20. MINTER del HiPer+

La MINTER le permite al usuario tener acceso a numerosas 
funciones: 

• Encender o apagar el receptor, ponerlo en Modo Sleep o en 
Modo Energía Cero.

• Activar o desactivar el registro de datos (tecla FN).

• Cambiar el modo de información del receptor.

• Mostrar el número de satélites GPS (verde) y GLONASS 
(naranja) rastreados (LED de ESTADO).

• Mostrar el estado de registro de datos (LED de REGISTRO).

• Mostrar cada vez que los datos se registren en la memoria 
interna (LED de REGISTRO).

• Mostrar el estado del modo de post-procesamiento (estático o 
dinámico) al ejecutar un levantamiento Cinemático de Post-
Procesamiento con la ayuda de la tecla FN (LED de 
REGISTRO).

Power key

FN key (function/recording)

REC (recording LED)

STAT (status LED) BATT (battery LED)

RX (modem LED)

Reset Key
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• Mostrar el estado (carga alta, carga intermedia, o carga baja) de 
la batería (LED de la BATERÍA).

• Mostrar la fuente de energía para el HiPer+ (LED de la 
BATERÍA).

• Mostrar el estado del módem y si recibe señales (LED del 
MÓDEM).

Utilice el software PC-CDU para definir los valores de la MINTER. 
Consulte el Manual del Usuario del PC-CDU para obtener 
información sobre otras posibles configuraciones de la MINTER.

1. Conecte su receptor y computadora. Vea “Conectar el HiPer+ a 
una Computadora” en la página 2-5 para obtener detalles sobre 
este procedimiento.

Y

Habilite la negociación RTS/CTS (Figura 2-21)

Figura 2-21. Parámetros de Conexión – Valores de la MINTER
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2. Haga clic en Configuration->Receiver (Figura 2-22).

Figura 2-22. Configuration->Receiver

3. Haga clic en la pestaña MINTER, defina los siguientes 
parámetros y haga clic en Apply (Figura 2-23 on 
la página 2-27). Lea las páginas siguientes para obtener las 
descripciones de estos parámetros.

• Intervalo de registro en la página 2-27

• Máscara de elevación para el archivo de registro en la 
página 2-27

• Prefijo del nombre de archivo en la página 2-27

• Siempre anexe al archivo en la página 2-28

• Modo de Creación de Archivos en la página 2-28

• Modo Automático de Rotación de Archivos (AFRM) en la 
página 2-28

• Modo de la tecla FN en la página 2-30

• Modo dinámico de colección de datos inicial en la 
página 2-31

• Inicio automático de registro de datos en la página 2-31
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Figura 2-23. Configuración del Receptor – Pestaña MINTER

Parámetro del Intervalo de Registro

Este parámetro especifica el intervalo de salida de mensajes en 
el archivo de registro cuando la tecla de función MINTER 
(presionada de 1 a 5 segundos) activa el registro de datos. Este 
valor se utiliza no sólo cuando se registra un sólo archivo de 
registro sino cuando se registran datos del receptor en el modo 
AFRM. Los valores son 1–86400 segundos. 

El valor por defecto es un segundo.

Parámetro Máscara de Elevación para Archivo de Registro 

Este parámetro especifica el ángulo de elevación mínimos para 
los satélites cuyos datos quedarán registrados en los archivos 
del receptor al presionar la tecla FN. 

El valor por defecto es cinco grados.

Parámetro de Prefijo de Nombre de Archivo 

Este parámetro especifica qué prefijo se añadirá a los nombres 
de los archivos del receptor creados al presionar FN. El prefijo 
puede tener hasta 20 caracteres de extensión. 

El valor por defecto es log (registro). 
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Los nombres de archivo de registro presentan la siguiente 
estructura:

<prefix><month><day><sequential alphabet letter>

El nombre del archivo depende tanto del momento en que se 
creó el archivo (mes y día) como de sufijos adicionales de letras 
para evitar confusión entre los archivos creados en el mismo 
día. 

Parámetro Siempre Anexar al Archivo

Si desea que los datos nuevos del receptor sean anexados a un 
archivo de registro existente, ingrese el nombre de archivo 
deseado en este parámetro. El valor puede tener hasta 20 
caracteres.

Parámetro Modo de Creación de Archivos

Este parámetro tiene dos modos posibles de operación:

• Archivo de registro – Si se ha seleccionado el botón de 
radio de archivo de registro, presionando la tecla FN, se 
cerrará el archivo de registro actual. Si el registro de datos 
se encuentra deshabilitado, al presionar la tecla FN se 
abrirá un nuevo archivo de registro.

• AFRM – Si se ha seleccionado el botón de radio AFRM, al 
presionar FN este modo quedará habilitado. Si AFRM se 
encuentra habilitado, al presionar FN quedará 
deshabilitado.

Parámetros del Modo Automático de Rotación de Archivos 
(AFRM) 

Los receptores TPS pueden rotar automáticamente archivos de 
registro. Durante un evento de “rotación de archivos, el receptor 
cierra el archivo en uso y abre un nuevo archivo de acuerdo al 
cronograma definido por el usuario. Los parámetros de Período 
y Fase se especifican en este cronograma. La rotación de 
archivos comienza cuando el Período del módulo de tiempo del 
receptor es igual a Fase. Es decir, un archivo de registro nuevo 
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se abre inmediatamente antes de la época programada haciendo 
que los datos identificados con esta época se registren en el 
archivo de registro nuevo.

Al abrir un archivo de registro nuevo, el receptor habilita el 
grupo de mensajes por defecto generados con el período de 
salida por defecto. Tanto el grupo de mensajes por defecto y el 
período de salida por defecto son programables.

• Period – especifica la duración de tiempo de cada archivo de 
registro creado en el modo AFRM.

Los valores varían de 60 a 864000 segundos. El valor por 
defecto es 3600 segundos.

• Phase – especifica la “fase” (cambio de tiempo constante) de 
crear archivos de registro múltiples en el modo AFRM.

Los valores son de 0 a 86400 segundos. El valor por defecto es 
cero segundos.

• Files (total) – contador que especifica cuántos archivos de 
registro múltiple deben ser creados en AFRM hasta que este 
modo se apague automáticamente.   Este contador disminuye en 
cada rotación de archivo hasta que su valor llega a cero, 
entonces la rotación de archivos automáticamente se detiene.

Observe que un archivo de registro se abre inmediatamente 
después de activar AFRM. Este archivo de inicio no se 
considera un evento de rotación de archivos; el contador AFRM 
no disminuirá.

Los valores son 0 [231-1]. El valor por defecto es 0 (cero). Cero 
significa que es posible crear un número ilimitado de archivos 
de registro.

AVISO
La memoria del receptor tiene capacidad para 
hasta 256 archivos.
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• Files (remain) – especifica el número de archivos que el 
receptor aún puede crear en AFRM.

Los valores son 0 a [231-1]. El valor por defecto es cero.

• Automatically remove olde files (eliminar automáticamente 
archivos antiguos) – si no existe memoria libre para registrar 
datos, automáticamente se borrará el primer archivo de registro. 
Si se habilita este parámetro, su receptor eliminará el archivo 
con la hora/fecha de creación más antigua. AFRM debe estar 
habilitado para utilizar esta característica FIFO (Primero en 
Entrar, Primero en Salir, por sus siglas en inglés).

El valor por defecto es Off (desactivado).

Parámetro Modo de la Tecla FN 

Utilice estos dos botones de radio para programar cómo 
reaccionará el receptor al presionar la tecla FN.

• Control del modo de parpadeo del LED – al presionar la tecla 
FN alternará entre los modos de información normal/extendida 
de la MINTER e iniciará/detendrá el registro de datos del 
levantamiento Estático.

– Si presiona la tecla FN durante menos de 1 segundo: cambia 
el modo de información (Modos Normal o Información 
Extendida (EI)).

– Si presiona la tecla FN 1 a 5 segundos: inicia / detiene el 
registro (modo de post-procesamiento estático).

• Occupation mode switch (control del modo de ocupación) – al 
presionar la tecla FN (durante menos de un segundo) se 
insertará en el archivo de registro correspondiente un mensaje 
indicando que el tipo de levantamiento ha cambiado de estático 
a cinemático, o viceversa. Si el LED de REGISTRO parpadea 
verde, el modo actual es dinámico, si parpadea naranja, el modo 
actual es estático. Para obtener más información, revise la Tabla 
4-1 de la página 4-4, y consulte el Manual del Usuario de la 
MINTER y el Manual del Usuario del PC-CDU.
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Parámetro del Modo Dinámico de Colección Inicial de Datos

Estos botones de radio especifican el descriptor de tipo de 
ocupación de inicio insertado al comienzo de los archivos 
registrados del receptor. Seleccione Estático o Cinemático para 
especificar que el archivo de registro correspondiente se 
iniciará con una ocupación estática (PARAR) o cinemática 
(SEGUIR, Trayectoria), respectivamente.

Parámetro de inicio automático de Registro de Datos

Estos botones de radio le permiten programar el 
comportamiento de su receptor en caso ocurriese un corte de 
energía.

El Tabla 2-1 le presenta los diferentes escenarios disponibles y 
los resultados después de restaurar la energía en el receptor. 
“Archivo especificado” hace referencia al nombre de archivo 
ingresado en el parámetro Always append to file.

Tabla 2-1. Comportamiento del Parámetro de Registro de Datos

Antes del 
corte de 
energía

Resultados de los Botones de Radio Habilitados

Apagado (Off) Encendido (On) Siempre (Always)

1
Datos del 
receptor 
archivados 
en un 
archivo 
específico.

El registro de 
datos no se 
reanudará una vez 
que la energía se 
haya restaurado.

El receptor 
reanudará el 
registro de datos 
en el mismo 
archivo cuando se 
reestablezca la 
energía.

El receptor 
reanudará el 
registro de datos 
en el mismo 
archivo cuando se 
reestablezca la 
energía.

2
Datos del 
receptor 
registrados 
en el archivo 
por defecto

El registro de 
datos no se 
reanudará cuando 
se restablezca la 
energía

Se abrirá un nuevo 
archivo de registro 
cuando se 
restablezca la 
energía y los datos 
se registrarán en 
este archivo.

Se abrirá un nuevo 
archivo de registro 
cuando se 
restablezca la 
energía y los datos 
se registrarán en 
este archivo.
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Asimismo, si Always se encuentra habilitado, su receptor 
automáticamente empezará a registrar datos (a un archivo 
recientemente creado o a un archivo existente) en los tres casos 
siguientes:

• Después de presionar la tecla de encendido de la MINTER.

• Después de reinicializar el receptor (con PC-CDU o la tecla 
de reinicialización).

• Después de sacar al receptor del Modo Sleep.

3
Archivo 
especificado, 
el registro de 
datos del 
receptor no 
se ha 
iniciado.

Ningún archivo se 
abrirá con este 
nombre.  El 
registro de datos 
no se iniciará 
cuando se 
restablezca la 
energía.

Ningún archivo se 
abrirá con este 
nombre.  El 
registro de datos 
no se iniciará al 
restablecerse la 
energía.

Un archivo de 
registro con este 
nombre se abrirá y 
el registro de 
datos empezará 
tan pronto como 
se restablezca la 
energía.

4
No se 
especifica 
archivo, el 
registro de 
datos del 
receptor se 
encuentra 
apagado.

No se iniciará el 
registro de datos 
cuando se 
restablezca la 
energía.

No se iniciará el 
registro de datos 
cuando se 
restablezca la 
energía

Se abrirá un 
archive de registro 
con un nombre 
por defecto y se 
iniciará el registro 
de datos tan 
pronto como se 
reestablezca la 
energía.

Tabla 2-1. Comportamiento del Parámetro de Registro de Datos

Antes del 
corte de 
energía

Resultados de los Botones de Radio Habilitados

Apagado (Off) Encendido (On) Siempre (Always)
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Configuración del Radio
El radio interno de su HiPer+ y el radio base pueden configurarse 
de manera diferente de acuerdo con sus necesidades y condiciones 
de trabajo. El programa de software requerido para configurar el 
radio módem es diferente dependiendo de la configuración de su 
receptor, y le permite:

• Acceder a la memoria interna

• Configurar el módem

• Verificar o cambiar la configuración del módem

Las siguientes secciones le ofrecen información básica de 
configuración del radio para radio módems UHF y GSM.

AVISO
Puede configurar su receptor sin un radio 
módem. Si ese es el caso, por favor vaya a 
“Colectando Almanaques” en la página 2-52.

Configuración de un Radio Módem UHF
Para acceder a su radio módem PDL UHF, usted debe crear una 
conexión en cadenagf entre el puerto de serie del HiPer+ (A o 
D) y el radio módem (Puerto C) usando PC-CDU. Después 
puede activar el programa de configuración PDL en su PPC y 
continuar con la configuración del radio.

1. Conecte su receptor y la computadora. Vea “Conectar el 
HiPer+ a una Computadora” en la página 2-5 para obtener 
información sobre este procedimiento.

Y

Use una velocidad de transferencia en baudios de 38400.
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2. Una vez conectado, haga clic en el Modo File->Manual 
para crear una conexión en cadena entre el puerto del 
receptor (A o D) y el módem PDL del HiPer+ 
(Figura 2-24).

Figura 2-24. File->Manual Mode

3. Digite cada uno de los siguientes comandos, presionando 
Enter (o haciendo clic en Send command (Enviar 
comando)) después de cada comando.

%%set,dev/ser/c/rate,38400

%%set,dev/ser/c/echo,/cur/term

%%set,dev/ser/c/imode,echo

%%set,cur/term/eoff,QUIT

%%set,cur/term/echo,/dev/null

%%set,cur/term/imode,echo

%%set,cur/term/echo,/dev/ser/c

La pantalla del Modo Manual muestra RE002%% en 
respuesta a cada uno de estos comandos. Cuando termine, 
debe tener siete respuestas (Figura 2-25 en la página 2-35).
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Figura 2-25. Modo Manual – Respuestas a los Comandos

PUNTA
Guarde este grupo de comandos en un archivo 
script y después cargue este archivo en el 
receptor mediante una sencilla operación. Para 
crear un archivo script, revise el Apéndice A.

4. Haga clic en Disconnect (Figura 2-25).

5. Ejecute el Programa de Configuración de Radio PDL 
(pdlconf.exe) de Pacific Crest (Figura 2-26 en 
la página 2-36). 

Asegúrese de tener la versión más reciente (2.20 o 
superior). Las actualizaciones de este software están 
disponibles en el sitio web de Pacific Crest 
(www.paccrst.com/download/upgrade.htm).
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Figura 2-26. Pantalla Principal de Configuración del Radio PDL

6. Haga clic en el logo de  Pacific Crest en la esquina 
superior izquierda de la pantalla principal (Figura 2-27).

Figura 2-27. Menú del Icono de la Esquina Superior Izquierda de PDL

7. En el menú emergente, haga clic en Set Capture Method 
(Definir Método de Captura)->Soft Break (Figura 2-28 en 
la página 2-37).
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Figura 2-28. Definir Método de Captura->Corte Suave

8. Haga clic en Load (Cargar) para conectar al radio 
(Figura 2-29).

Figura 2-29. Hacer clic en Load
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9. En la pestaña Identification, digite la información del 
Propietario (Figura 2-30).

Figura 2-30. Pestaña Identificación de PDL

La pantalla de identificación muestra la información actual 
relacionada con la versión de firmware, número de serie, 
frecuencia y potencia del radio módem.

10. Haga clic en la pestaña Radio Link (Radio Enlace) y defina 
los siguientes parámetros (Figura 2-31 en la página 2-39):

• Manual – habilitar

• Canal TX RX – defina canal y frecuencia según desee

• Link Rate – establezca en 9600 (requiere un tipo de 
modulación de GMSK)

• Digisquelch – defina en High (Alto) para el Rover; 
Bajo (Low) o Desactivado (Off) para la Estación Base

• Forward Error Correction (Corrección de Error 
Adelantada) – habilitar

• Scrambling (Codificación) – habilitar

• Local Address – deje en 0
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Figura 2-31. Pestaña Radio Enlace de PDL

AVISO
Los radios PDL de la Base y del HiPer+ (Rover) 
deben configurarse con las mismas 
características de Canales, Radio Enlace (con 
excepción de Digisquelch) y los parámetros de 
Interfaz de Serie.

11. Haga clic en la pestaña de la Interfaz Serial y defina los 
siguientes parámetros (Figura 2-32 en la página 2-40):

• Velocidad de transferencia en baudios– 38400

• Paridad – Sin paridad

AVISO
La paridad siempre debe ser None (Sin 
Paridad).

• Modo – Transparente con Intervalo de Espera EOT
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Figura 2-32. Pestaña de la Interfaz Serial PDL

12. Si realizó cambios, haga clic en el botón Program del lado 
izquierdo de la pantalla para guardarlos en la memoria del 
módem (Figura 2-33).

Figura 2-33. PDL – Hacer clic en Program

13. Haga clic en Close (Cerrar) y después en Exit (salir) para 
salir del programa (Figura 2-34 en la página 2-41).
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Figura 2-34. Hacer clic en Close y después en Exit

14. Abra PC-CDU.

15. Haga clic en File->Connect.

16. En la pantalla Connection Parameters (Parámetros de 
Conexión), seleccione una velocidad de transferencia en 
baudios de 38400 y habilite la casilla de verificación 
Manual mode only (Sólo modo manual) (Figura 2-35), 
después haga clic en Connect (Conectar).

Figura 2-35. Parámetros de Conexión – Sólo Modo Manual
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17. En la pantalla Manual Mode, escriba los siguientes 
comandos, presionando Enter (o haciendo clic en Send 
command) después de cada comando. Cuando termine, 
debe tener seis respuestas (Figura 2-36).

QUIT

%%set,cur/term/imode,cmd

%%set,dev/ser/c/echo,/dev/null

%%set,dev/ser/c/imode,cmd

%%set,dev/ser/c/rate,38400

%%set,cur/term/rate,115200

Figura 2-36. Respuestas al Comando Modo Manual

18. Haga clic en Disconnect (Figura 2-36). Continúe con otras 
funciones de configuración u operación según requiera.
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Configuración de un Radio Módem GSM

AVISO
Para cumplir con los requerimientos de 
exposición a la RF, debe haber por lo menos 20 
cm entre el usuario y el radio módem GSM.

Para acceder a su radio módem GSM, necesitará utilizar el 
controlador externo FC-1000 y TopSURV de Topcon. Consulte 
el Manual de Referencia de TopSURV o el Manual del Usuario 
de TopSURV para obtener información más detallada sobre la 
configuración.

AVISO
Los parámetros de configuración son similares, 
independientemente del software utilizado para 
configurar un módem GSM.

A diferencia de los radio módems UHF y PDLCONF, 
TopSURV automáticamente conecta el receptor y los tableros 
del módem para realizar la configuración. Cuando configure 
radios, configure los radios de la Base y el Rover 
independientemente.

1. Con el cable RS232, conecte su controlador externo (FC-
1000) al puerto de serie A del receptor.

2. Presione los botones de encendido en el receptor y en el 
controlador externo para encenderlos e inicie TopSURV.
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3. Haga clic en Job->Config->Survey para abrir el cuadro de 
diálogo Select Survey Config (Figura 2-37).

Figura 2-37. Seleccionar una Configuración del Levantamiento

4. De la lista desplegable GPS+ Config, seleccione My RTK, 
o el nombre de la configuración de levantamiento de su 
GPS+ , y haga clic en el botón “...” (continuar) 
(Figura 2-37).

PUNTA
Si ésta es una configuración nueva, consulte el 
Manual de Usuario de TopSURV para el 
procedimiento a utilizar para configurar un 
levantamiento nuevo. De lo contrario, siga los 
siguientes pasos para configurar su radio.

5. Presione Next para ubicar la pantalla de configuración de 
Radio de la Base o el Rover, generalmente un par de 
cuadros de diálogo después del cuadro de diálogo Select 
Survey Config.

6. En el cuadro de diálogo de configuración del radio, 
seleccione el radio módem GSM apropiado y defina los 
siguientes parámetros (Configuración del Radio de la Base 
o del Rover (Figura 2-37 en la página 2-44):
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Figura 2-38. Configuración del Radio de la Base o del Rover

• Puerto – C para radio módems internos o D para radio 
módems externos

• Paridad – Sin paridad

• Datos – 8

• Velocidad de transferencia en baudios – 9600

• Bits de parada – 1

7. Presione ConFigura GSM para acceder al cuadro de 
diálogo de parámetros de Teléfono Celular apropiado e 
ingrese los siguientes parámetros para la Base o para el 
Rover (Figura 2-38).

Figura 2-39. Definir Parámetros del Teléfono Celular de la Base o del Rover 

• Para la radio de la Base – Si su módem GSM no 
requiere un PIN, deje este campo en blanco. 
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El radio de la Base es Slave, sólo recibe llamadas de las 
estaciones Rover, por lo que no se requiere un número 
de teléfono.

• Para el radio del Rover – Si su módem GSM no 
requiere un PIN, deje este campo en blanco. 

La radio del Rover es Master, envía llamadas a la 
estación Base. Se requiere el número de teléfono de la 
estación Base, por lo que debe tenerlo disponible para 
ingresar en este momento, o seleccione el número 
correcto de la lista de números telefónicos (en caso que 
esté disponible). 

En este momento, puede presionar Add para guardar el 
número en la lista o puede presionar Delete para 
eliminar los números que no desee de la lista.

8. Presione OK para regresar a la pantalla de configuración 
del radio. Continúe con otras configuraciones o funciones 
de operación según requiera.

Configuración del Módulo Bluetooth
Utilice el programa de configuración del módulo Bluetooth y su 
computadora para:

• Acceder al módulo de tecnología inalámbrica Bluetooth

• Configurar el módulo Bluetooth

• Verifique o cambia la configuración del módulo

Para acceder al módulo de tecnología inalámbrica Bluetooth, 
primero descargue e instale BTCONF, después conecte su 
computadora y el receptor y ejecute el programa de configuración.

1. Cree o ubique la siguiente carpeta:

C:\Program Files\TPS\BTCONF

2. Descargue btconf.zip del sitio web de TPS y descomprímalo en 
la carpeta BTCONF.  Este archivo zip contiene Btconf.exe, el 
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archivo ejecutable para el programa de configuración del 
módulo Bluetooth.

Cada vez que ejecute BTCONF y configure el módulo Bluetooth, 
BTCONF guarda sus configuraciones en un archivo (btconf.ini). 
BTCONF actualiza automáticamente el archivo cada vez que haga 
cambios en las configuraciones del módulo Bluetooth.

PUNTA
Para mantener configuraciones únicas del 
módulo Bluetooth para fines diferentes, copie el 
BTCONF en carpetas diferentes.

Para desinstalar o eliminar, BTCONF, borre cualquiera de los 
directorios o carpetas BTCONF aplicables y los accesos directos a 
BTCONF.

Una vez que tenga disponible BTCONF, siga los siguientes pasos 
para configurar el módulo Bluetooth.

1. Con el cable RS232, conecte el puerto de serie de su 
computadora (generalmente COM1) en el puerto de serie A del 
receptor.

2. Presione los botones de encendido en el receptor y en la 
computadora para encenderlos.
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3. Ejecute el programa de configuración del módulo Bluetooth 
(Btconf.exe) (Figura 2-40).

Figura 2-40. Pantalla Principal de Configuración del Módulo Bluetooth

Observe que la esquina inferior izquierda muestra el estado 
“Desconectado” para la computadora y el módulo Bluetooth.

Para conocer la versión BTCONF e información de derechos de 
autor, haga clic en el botón About (Acerca de).

4. En la lista desplegable de la esquina superior derecha, 
seleccione el puerto de serie de la computadora (generalmente 
COM1) que se utiliza para la comunicación (Figura 2-41).

Figura 2-41. Seleccionar el Puerto de Comunicación y haga clic en Connect
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5. Haga clic en Connect para conectar la computadora y el 
módulo Bluetooth (Figura 2-41 en la página 2-48).

Una vez que el receptor y la computadora se encuentren 
conectados a través de BTCONF, la pestaña Identification 
(Figura 2-42) muestra la siguiente información:

• Nombre Bluetooth– el nombre del módulo Bluetooth, 
definido en la pestaña Parameters.

• Dirección Bluetooth – la dirección electrónica exclusiva 
para su módulo Bluetooth.

• Versión del firmware – versión actual del firmware del 
módulo Bluetooth.

Figura 2-42. Pestaña Identification de BTCONF

Observe que el puerto de comunicación y la velocidad de 
transferencia en baudios aparecen en la esquina inferior 
izquierda de la pantalla.

6. Haga clic en la pestaña Parameters (Figura 2-43 en la 
página 2-50). La pestaña Parameters define la información de 
identificación y seguridad de su módulo Bluetooth. Lla sección 
de seguridad le permite definir los datos de seguridad y los 
parámetros de acceso no autorizado para el módulo Bluetooth.
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7. Ingrese hasta 14 caracteres para definir un nombre único para el 
módulo Bluetooth (Figura 2-43), y haga clic en Apply.

Figura 2-43. Pestaña Parameters de BTCONF

8. Para definir los parámetros de seguridad (Figura 2-44 en la 
página 2-51), ingrese y habilite las siguientes opciones, después 
haga clic en Apply:

• PIN del Bluetooth– ingrese hasta 16 caracteres para 
especificar un número de identificación personal para el 
módulo Bluetooth.

• Encriptación – habilítela para hacer que el módulo 
Bluetooth encripte datos enviados inalámbricamente. Para 
leer datos encriptados, el usuario debe tener el mismo PIN 
utilizado en el dispositivo que envió los datos.

• Autenticación – habilítela para solicitar un PIN antes que 
dos dispositivos habilitados con el Bluetooth (como por 
ejemplo, el receptor y una computadora) puedan establecer 
un enlace de comunicación. Los dos dispositivos deben 
utilizar el mismo PIN.

AVISO
Si no necesita configuraciones de seguridad, 
deje estos parámetros deshabilitados.
Topcon Manual de Instrucciones del HiPer+



Configuración del Módulo Bluetooth

2-51
Figura 2-44. Parámetros Security de BTCONF

9. Haga clic en la pestaña Serial Interface (Figura 2-45). Habilite 
Echo para mostrar las respuestas del módulo Bluetooth y los 
comandos correspondientes en el terminal de la computadora. 
De ser necesario, haga clic en Apply.

Figura 2-45. Pestaña Serial Interface de BTCONF
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10. Hacer clic en Disconnect después en Exit (Figura 2-46) para 
salir BTCONF.

Figura 2-46. Hacer clic en Disconnect y después en Exit

Colectando Almanaques
Cada satélite transmite un mensaje (almanaque) que da la órbita 
aproximada de sí mismo y de todos los demás satélites.  Si el 
receptor tiene un almanaque, usted puede reducir 
considerablemente el tiempo requerido para buscar y capturar las 
señales satelitales.

El receptor actualiza regularmente el almanaque y guarda el 
almanaque más reciente en su Memoria de Acceso Aleatorio No 
Volátil (NVRAM).

1. Instale el receptor en una ubicación con una visión despejada 
del horizonte.

2. Encienda el receptor.
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AVISO
Si después de transcurridos 15 minutos el 
receptor no ha capturado satélites, tal vez 
necesite borrar la NVRAM. Vea “Borrar la 
NVRAM” en la página 4-20 para obtener 
información sobre este procedimiento.

Necesitará colectar o actualizar el almanaque:

• Si el receptor ha estado apagado durante un tiempo prolongado.

• Si la última posición conocida del receptor, guardada en la 
NVRAM se diferencia de la posición actual en varios cientos de 
kilómetros.

• Después de cargar un nuevo OAF.

• Después de cargar un firmware nuevo.

• Después de borrar la NVRAM.

• Antes de iniciar el levantamiento.

La colección y/o actualización de un almanaque puede demorar 
hasta 15 minutos.
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Apuntes:
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Capítulo 3

P/N
Instalación y 
Levantamiento
3-1
El presente capítulo describe:

• Instalación del HiPer+

• Instalación de la estación Base RTK

• Instalación del Rover RTK

• Levantamiento básico con el HiPer+

Puede utilizar su HiPer+ como estación Rover o como estación 
Base con un radio externo opcional.

Instalación del Receptor HiPer+
Para instalar su receptor HiPer+, usted debe:

1. Configurar el receptor tal como se detalla en el Capítulo 2.

2. Configurar su estación Base o Rover.Vea “Instalación del 
Receptor Hiper+” en la página 3-2.

3. Medir la altura de la antena. Vea “Medición de la Altura de la 
Antena ” en la página 3-2.

4. Empezar a colectar datos.Vea “Colectar Datos” en 
la página 3-5

Todos los receptores HiPer+ incluyen una antena interna 
microbanda. Esta antena puede capturar señales L1/L2 de satélites 
GPS y GLONASS.
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Instalación del Receptor Hiper+
Esta sección asume que usted ya ha configurado su receptor 
utilizando el PC-CDU.

1. Coloque el HiPer+ en el trípode o bípode apropiado.

2. Centre el receptor en el punto en el que se colectarán los 
datos. En la mayoría de aplicaciones, deber ser una 
ubicación con una vista despejada del horizonte.

3. Si utiliza el HiPer+ como estación Base, conecte el radio 
externo al receptor.

Medición de la Altura de la Antena 
La ubicación de la antena en relación con el punto a ser medido 
es sumamente importante tanto para levantamientos en los que 
la elevación de los puntos es importante como en 
levantamientos en los que lo únicamente se requiere la 
ubicación horizontal. Los levantamientos horizontales 
frecuentemente son más grandes en áreas encajar con seguridad 
en un nivelado, por lo tanto el ajuste de la antena debe ser 
tridimensional para luego proyectarse en un plano 
bidimensional.

El receptor calcula las coordenadas del centro de fase de la 
antena. Para determinar las coordenadas del marcador de 
estación, el usuario debe especificar lo siguiente:

• Altura medida de la antena por encima del marcador de 
estación

• Método utilizado para medir la altura de la antena

• Modelo de la antena utilizada

Las antenas realizan dos tipos de mediciones:

• Vertical – medida desde el marcador al punto de referencia 
de la antena (ARP) ubicado en el extremo inferior del 
receptor en la base de las roscas de montaje.
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• Inclinada – medida desde marcador al borde inferior de la 
marca de medición de altura inclinada (SHMM) ubicada en 
los paneles posteriores del receptor.

4. Medir la altura de la antena sobre el punto o marcador.

Figura 3-1 ilustran las desviaciones de la antena y 
Tabla 3-1 le da las mediciones de desviación. (Vea 
Figura 1-2 en la página 1-15 y Figura 1-4 en la página 1-18 
para obtener el SHMM exacto.)

Figura 3-1. Desviaciones de la Antena del HiPer+

• Desviación vertical SHMM a ARP = 30.50mm

• Desviación vertical SHMM a ARP = 77.75mm

El punto real medido al efectuar un levantamiento con 
GPS/GLONASS se denomina Centro de Fase de la antena. 
Es similar al punto medido por el distanciómetro en un 
prisma. El usuario debe ingresar la desviación del prisma 
para compensar este punto que no es una superficie física 

Table 3-1. Mediciones de la Desviación de la Antena del HiPer+

A Centro de Fase L1 A Centro de Fase L2

Hacia arriba 102mm 94mm

SHMM

ARP

30.50mm

77.75mm
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del prisma. En el caso de una antena GPS/GLONASS, se 
ingresa la desviación dependiendo del tipo de medición 
realizada. Para la medición vertical, simplemente se añade 
la desviación a la altura vertical medida para producir una 
altura vertical “correcta”. En el caso de la altura inclinada, 
primero es necesario calcular la altura vertical utilizando el 
radio de la antena y después se añade la desviación. Las 
desviaciones no tienen el mismo número debido a la 
diferencia en la ubicación entre el punto de medición 
inclinado y el punto de medición vertical

5. Registre el número de serie del receptor, la altura de la 
antena, el nombre del punto, y la hora de inicio en las notas 
de campo.

6. Presione la tecla de encendido y suéltela para encender el 
receptor. La luz (LED) de ESTADO (estado) parpadeará 
rojo al principio. 

7. Una vez que el receptor haya capturado uno o más satélites, 
la luz de ESTADO parpadeará verde para los satélites GPS, 
naranja para los satélites GLONASS, y emitirá un parpadeo 
rojo corto en caso que no haya determinado una posición. 
Cuatro o más satélites ofrecen un posicionamiento óptimo.

8. Una vez que el parpadeo rojo corto desaparece, esto indica 
que el receptor tiene una posición y es posible comenzar el 
levantamiento. Debe esperar que aparezcan las luces verde 
y naranja antes de iniciar la colección de datos. Al hacerlo 
se asegura que el receptor tiene la fecha y hora correctas y 
ha captado suficientes satélites, garantizando de esta 
manera, la buena calidad de los datos.

El proceso de captar satélites normalmente demora menos 
de un minuto. En un área nueva, con follaje espeso, o 
después de reinicializar el receptor, podría demorar algunos 
minutos.
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Colectar Datos
9. Para empezar a colectar datos presione y mantenga 

presionada la tecla de función FN durante más de uno y 
menos de cinco segundos.

10. Suelte la tecla FN cuando el LED de REGISTRO esté 
verde. Esto indica que un archivo ha sido abierto y que se 
ha iniciado la colección de datos. El LED de REGISTRO 
parpadea cada vez que se guardan datos en la memoria 
interna.

PUNTA
Usted puede utilizar el PC-CDU para configurar 
el registro de datos. Vea “Configuración de la 
MINTER” en la página 2-24 o consulte el Manual 
del Usuario del PC-CDU para obtener mayor 
información.

11. Cuando termine, presione y mantenga presionada la tecla 
FN hasta que se apague la luz del LED de REGISTRO. 

12. Presione y mantenga presionada la tecla de encendido 
hasta que se apaguen todas las luces, después suéltela.
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Levantamiento con el HiPer+
El receptor HiPer+ puede utilizarse para realizar los siguientes tipos 
de levantamiento:

• Estático

• Cinemático

• Cinemático en tiempo real (RTK)

Levantamiento Estático
El levantamiento estático es el modo de levantamiento clásico, 
adecuado para todos los tipos de líneas de base (cortas, 
medianas y largas). Al menos dos antenas del receptor, 
perpendiculares a las marcas de levantamiento, colectan 
simultáneamente datos sin procesar en cada extremo de una 
línea de base durante cierto período de tiempo. Estos dos 
receptores rastrean cuatro o más satélites comunes, tienen una 
tasa de transferencia de registro común (5–30 segundos) y los 
mismos ángulos de error de elevación. La duración de las 
sesiones de observación puede variar entre algunos minutos y 
varias horas. La duración óptima de la sesión de observación 
depende de la experiencia del topógrafo así como de los 
siguientes factores:

• La longitud de la línea de base medida

• El número de satélites visibles

• La geometría satelital (DOP)

• La ubicación de la antena

• El nivel de actividad ionosférica

• Los tipos de receptores utilizados

• Los requerimientos de precisión

• La necesidad de resolver las ambigüedades de la fase de 
portadora
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Por lo general, los receptores de una frecuencia se utilizan para 
líneas de base con longitudes de menos de 15 kilómetros (9.32 
millas). Para líneas de 15 kilómetros o más, utilice receptores 
de doble frecuencia.

Los receptores de doble frecuencia ofrecen dos ventajas 
importantes. En primer lugar, los receptores de doble 
frecuencia pueden estimar y eliminar casi todos el efecto 
ionosférico de las mediciones de código y de fase de portadora, 
ofreciendo mayor precisión que los receptores de una 
frecuencia en líneas de base largas o durante tormentas 
ionosféricas.

En segundo lugar, los receptores de doble frecuencia requieren 
un menor tiempo de observación para alcanzar el requerimiento 
de precisión deseado.

Después de completar el levantamiento, los datos que los 
receptores colectan pueden descargarse a una computadora y 
procesarse utilizando un software de post-procesamiento 
(Pinnacle, por ejemplo).

El siguiente procedimiento describe los pasos que debe seguir 
el operador para realizar un Levantamiento Estático con 
MINTER.

1. Conecte su receptor y su computadora. Vea “Conectar el 
HiPer+ a una Computadora” en la página 2-5 para obtener 
información sobre este procedimiento.

2. Abra PC-CDU, haga clic en Configuration->Receiver
->MINTER y especifique los siguientes parámetros, 
después haga clic en Apply (Figura 3-2 en la página 3-8):

• Intervalo de Registro – 15 segundos

• Angulo de la Máscara de la Elevación – 15 grados

• Prefijo del Nombre de Archivo– últimos 3 dígitos del 
número de serie del receptor
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• Control del modo de parpadeo del LED – habilita 
iniciar y detener registro de datos estáticos utilizando la 
tecla FN

Figura 3-2. Configuration->Receiver->MINTER

3. Haga clic en la pestaña Advanced y después en la pestaña 
Multipath, defina los siguientes parámetros, después haga 
clic en Apply (Figura 3-3):

• Reducción Multipath de Código – habilitar

• Reducción Multipath de la Portadora – habilitar

Figura 3-3. Advanced->Multipath
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4. Haga clic en la pestaña Loop Management (Gestión de 
Bucle) y defina los siguientes parámetros, después haga 
clic en Apply (Figura 3-4):

• Enable Co-Op tracking (Habilitar rastreo Co-op) – 
habilitar

• Static mode (Modo estático) – habilitar

Figura 3-4. Advanced->Loop Management

5. Configure cada antena y receptor tal como se describe en 
“Instalación del Receptor HiPer+” en la página 3-1.

6. Comience el levantamiento.

Levantamiento Cinemático
Usted puede utilizar el método de levantamiento cinemático 
para un levantamiento Parar y Seguir (Stop and Go) en un 
levantamiento continuo Cinemático (trayectoria).

Levantamiento Parar y Seguir 

El receptor estacionario (Estación Base) se configura en un 
punto conocido como por ejemplo una marca de 
levantamiento, o un punto desconocido. El receptor rastrea 
continuamente satélites y registra datos sin procesar en su 
memoria. El receptor del rover se instala en un punto 
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desconocido y colecta datos en el modo estático durante 2 a 
10 minutos.

1. Usando el PC-CDU, configure e instale la Base tal 
como se describe en “Levantamiento Estático” en la 
página 3-6.

2. Haga clic en Configuration->Receiver->MINTER, y 
configure el Rover con los siguientes parámetros, y 
después haga clic en Apply (Figura 3-5):

• Modo Tecla FN, Control de Modo de Ocupación – 
habilitar

• Modo dinámico de colección inicial de datos, Estático 
– habilitar

Vea Tabla 4-1 en la página 4-5 para obtener 
información sobre las funciones de la tecla FN y los 
estados del LED REC

Figura 3-5. Configuración de la MINTER del Rover

AVISO
Recuerde, los receptores, tanto Base como 
Rover, deben colectar datos desde los satélites 
comunes con una velocidad de registro de 
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datos común y con ángulos de máscara de 
elevación idénticos.

3. Configure el Rover en un punto desconocido y presione 
la tecla de encendido. Espere de dos a diez minutos 
para que el Rover colecte datos estáticos. El LED de 
REGISTRO estará naranja.

4. Verifique que la luz de ESTADO para los satélites 
rastreados.

5. Al terminar, presione la tecla FN durante menos de un 
segundo para indicarle al Rover que pase al modo 
cinemático. 

PUNTA
Recuerde, si el LED REC parpadea verde, el 
modo actual es dinámico, si parpadea naranja, 
el modo actual es estático.

6. Mueva el Rover a la ubicación siguiente (punto de 
levantamiento), y presione la tecla FN durante menos 
de un segundo para colectar datos en modo estático de 
dos a diez minutos.

7. Repita los pasos cinco y seis hasta que todos los puntos 
hayan sido levantados. El tiempo de ocupación para los 
puntos depende de los mismos factores de los que 
depende el método de levantamiento estático.

8. Al terminar, presione la tecla FN durante uno a cinco 
segundos para dejar de registrar datos. Apague el Rover 
en caso de ser necesario.

Este método de levantamiento GPS le permite al operador 
reducir el tiempo de ocupación del punto, permitiendo así, 
a las brigadas de trabajo en campo, levantar muchos más 
puntos en comparación con los otros métodos disponibles.
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Levantamiento Cinemático Continuo

El levantamiento cinemático continuo, también conocido 
como levantamiento de trayectoria, le permite al Rover 
moverse sin tener que pararse, registrar datos, moverse a 
otro punto, y hacerlo todo nuevamente.

Si el topógrafo conoce las coordenadas del punto de inicio, 
no necesitará inicializar el rover. La determinación de los 
parámetros de ambigüedad se realiza mientras el rover se 
mueve y se denomina “resolución de ambigüedad de una 
pasada”. Además, si el receptor deja de captar satélites 
(como en el caso de una obstrucción que obstaculice una 
vista despejada del horizonte), el receptor se reinicializará 
dinámicamente.

Después de completar el levantamiento, los datos sin 
procesar colectados por los receptores se bajan a una 
computadora y se procesan utilizando un software de post-
procesamiento (Pinnacle, por ejemplo).

1. Utilizando PC-CDU configure e instale la Base tal 
como se define en el “Levantamiento Estático” en la 
página 3-6.

2. Utilizando PC-CDU, haga clic en Configuration-
>Receiver->MINTER, y configure el Rover con los 
siguientes parámetros, después haga clic en Apply 
(Figura 3-5 en la página 3-10):

• Modo Tecla FN, Control del Modo de Ocupación – 
habilitar

• Modo dinámico de colección de datos inicial, 
Cinemático – habilitar

3. Coloque el Rover en un punto de inicio con 
coordenadas desconocidas y presione la tecla de 
encendido. Haga una pausa durante algunos minutos 
mientras el receptor encuentra un almanaque.

4. Verifique la luz de ESTADO de los satélites rastreados.
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5. Presione la tecla FN durante uno a cuatro segundos 
para empezar a registrar datos en el modo cinemático 
(el estado de la antena es cinemático).

6. Mueva el receptor Rover a lo largo de la trayectoria 
seleccionada. 

7. Una vez que el receptor Rover alcance el punto final de 
la trayectoria, haga una pausa durante algunos minutos.

8. Cuando termine, haga clic en la tecla FN para detener 
el registro de datos y apague el Rover.

Levantamiento Cinemático en Tiempo 
Real
El levantamiento cinemático en tiempo real (RTK) es un 
proceso GPS diferencial donde la información, tal como las 
correcciones diferenciales, se transmite en tiempo real desde 
una estación Base a una o más estaciones Rover.

Instalar una Estación Base RTK

Para configurar una estación Base RTK usando el PC-
CDU, siga los siguientes pasos:

1. Configure la antena del receptor de la estación Base tal 
como se describe en “Instalación del Receptor HiPer+” 
en la página 3-1.

2. Conecte un módem externo al Puerto C para un 
Legacy-E o un Puerto D para el HiPer+.

3. Instale el hardware tal como se muestra en Figura 3-6 
en la página 3-14. Esta instalación muestra una 
estación Base Legacy-E.
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Figura 3-6. Instalación de la Estación Base Legacy-E

AVISO
Conecte la antena de radio antes de pasar el 
módem al modo de transmisión.

4. Presione la tecla de encendido en el receptor.

5. Verifique la luz de ESTADO de los satélites rastreados.
Topcon Manual de Instrucciones del HiPer+



Levantamiento con el HiPer+

3-15
6. Conecte su receptor y su computadora. Vea “Conectar 
el HiPer+ a una Computadora” en la página 2-5 para 
este procedimiento.

7. Con el PC-CDU, haga clic Configuration->Receiver.

8. Haga clic en el botón Set all parameters to defaults 
(Reestablecer parámetros a los valores por defecto) 
ubicado en el extremo inferior de la pantalla de 
configuración del Receptor (Figura 3-7).

Figura 3-7. Restablecer Todos los Parámetros a sus Valores por Defecto

9. En la pantalla de Configuración del Receptor, 
seleccione la pestaña MINTER. Especifique las 
configuraciones deseadas. Consulte el Manual de 
Usuario de PC-CDU para obtener más información.
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10. Seleccione el rótulo Positioning y configure las 
Máscaras de Posición, el parámetro de la máscara de 
Elevación a 15 (Figura 3-8).

Figura 3-8. Configuración del Receptor– Posicionamiento

11. Seleccione el rótulo Base y defina los siguientes 
parámetros (Figura 3-9 en la página 3-17):

• GPS/GLO a la vez – habilitar

• Posición de la antena – ingrese los valores de Lat, Lon, 
and Alt.

O

Haga clic en Get from receiver (Obtenerlos desde el 
receptor).

O

Habilitar Averaged (Promediado) y (Intervalo 
Promediado) en segundos, después haga clic en Apply. 
Haga clic en Tools->Reset receiver y espere hasta que 
se complete el intervalo (lapso) de tiempo especificado. 
Verifique las coordenadas de la Base en la pestaña 
Base, la información debe corresponder a las 
coordenadas obtenidas del promedio. Haga clic en 
Refresh si las coordenadas son ceros.
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AVISO
Las coordenadas geodésicas de referencia que 
se especifican en el presente documento se 
relacionan con el centro de fase de la antena L1.

Figura 3-9. Configuración de la Pestaña Base

12. Seleccione la pestaña Ports y defina los parámetros de 
puerto (Figura 3-10 en la página 3-18). Use el puerto de 
serie C para un módem PDL interno, GSM, o Spread 
Spectrum (Espectro Ensanchado) 915 MHz/2.4 GHz.

• Exporte la lista desplegable – seleccione el tipo y el 
formato de las correcciones diferenciales.

• Período (seg) – ingrese el intervalo en el que el receptor 
generará correcciones diferenciales.

• Lista desplegable de velocidad en baudios – seleccione 
una velocidad en baudios (es decir, la velocidad a la 
cual se transmitirán mensajes diferenciales desde el 
receptor al módem).
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PUNTA
En el caso de módems Pacific Crest PDL (UHF), 
utilice una velocidad de transferencia en 
baudios de  38400. En el caso de módems 
Spread Spectrum 915 MHz/2.4 GHz, utilice una 
velocidad de transferencia en baudios de 
19200.

Figura 3-10. Configuración Base – Puertos

13. Haga clic en Apply. El receptor empezará a enviar 
datos al puerto seleccionado.

Si utiliza un módem externo de Pacific Crest PDL (UHF), 
siga estos pasos para configurar el módem :

14. Cuando termine con los pasos anteriores, presione el 
botón de encendido en el módem externo.

15. Seleccione una potencia de transmisión de radio con la 
barra de desplazamiento Low/High (Bajo/Alto) en el 
panel posterior del módem. Al estar en High, el LED 
AMP PWR estará encendido.
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16. Utilice el botón Channel para definir el canal de 
frecuencia. Verifique que el módem transmita las 
correcciones (el LED TX parpadeará rojo cada vez que 
se trasmitan datos).

Para más detalles sobre los valores disponibles para 
configurar la estación Base, consulte el Manual de Usuario 
del PC-CDU.

Instalar un Rover RTK

Debe seguir los siguientes pasos para instalar una estación 
Rover RTK. Usted ya debe haber programado el módem.

Figura 3-11 muestra la configuración del hardware para 
una estación Rover con un controlador externo.

Figura 3-11. Instalación de la Estación Rover del HiPer+
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1. Instale la antena del receptor de la estación Rover tal 
como se describe en “Instalación del Receptor HiPer+” 
en la página 3-1.

2. Conecte su receptor y su computadora. Vea “Conectar 
el HiPer+ a una Computadora” en la página 2-5 para 
obtener información sobre este procedimiento.

3. Haga clic en Configuration->Receiver.

4. Seleccione el rótulo Positioning y defina el parámetro 
Position Masks, Elevation Masks (degrees) (Máscaras 
de Posición, máscara de Elevación (grados)) a 15 
(Figura 3-8 en la página 3-16).

5. Seleccione el rótulo Rover y defina el Modo de 
Posicionamiento deseado (Figura 3-12). 

Figura 3-12. Configuración de la Pestaña Rover

Si seleccionó RTK Flotante o RTK Fijo, ajuste las 
siguientes configuraciones de los Parámetros RTK:

• Seleccione Extrapolación o Retardo.

–La extrapolación es para aplicaciones de latencia baja, 
salida de alta frecuencia (>= 5 Hz) RTK. El rover 
extrapolará las correcciones de la medición de la fase 
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de portadora de la estación base al calcular la posición 
RTK actual del rover.

–Retardo es para aplicaciones RTK de alta precisión de 
1 Hz.  El motor RTK del Rover calculará la posición 
RTK con retardo (para la época a la que corresponde el 
mensaje RTCM/CMR recientemente recibido) o la 
posición autónoma actual (mientras espera  nuevos 
mensajes RTCM/CMR desde la base).

• Seleccione el estatus de la antena durante RTK, ya sea 
en Estático o Cinemático.

• Especifique el nivel de fijación de Ambigüedad (no 
aplicable a RTK Flotante). Los botones de radio de 
Nivel de Fijación de Ambigüedad regulan el proceso 
del motor RTK, fijando ambigüedades de entero.   El 
motor RTK utiliza el indicador fijo de ambigüedad 
cuando se toman decisiones sobre si fijar o no 
ambigüedades. Bajo, Medio, y Alto corresponde a los 
estados de 95%, 99.5% y 99.9% del indicador.   
Mientras mayor sea el nivel de confianza especificada, 
mayor será el tiempo de búsqueda de ambigüedad de 
entero.

6. Seleccione la pestaña Ports y defina los siguientes 
parámetros para la Serie C (Figura 3-13 en 
la página 3-22):

• Importe la lista desplegable– seleccione el formato de 
corrección diferencial deseado.

• Período (seg) – dejarlo tal como está.

• Lista desplegable de velocidad en baudios – seleccione 
una velocidad en baudios (es decir, la velocidad a la 
cual se trasmitirán los mensajes diferenciales desde el 
módem al receptor).
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PUNTA
En el caso de módems de Pacific Crest PDL 
(UHF), utilice una velocidad de transferencia en 
baudios de 38400. En el caso de módems 
Spread Spectrum 915 MHz/2.4 GHz, utilice una 
velocidad de transferencia en baudios de 
19200.

Figura 3-13. Configuración del Rover – Puertos

7. Haga clic en Apply.

8. Haga clic en OK para cerrar la pantalla de 
Configuración del Receptor.

9. En la pantalla principal (Figura 3-14 en la página 3-23), 
verifique el campo LQ para asegurarse que el receptor 
esté obteniendo las correcciones diferenciales. 
Generalmente, el receptor empezará a enviar las 
coordenadas del centro de fase de la antena junto con el 
tipo de solución en un lapso de 10–30 segundos.
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Figura 3-14. Pantalla Principal PC-CDU

Las coordenadas geodésicas desplegadas en la pestaña Geo 
siempre se calculan en WGS84 y tienen cuatro tipos de 
solución.

• Independiente – donde el receptor calcula las 
coordenadas 3D en el modo autónomo sin utilizar 
correcciones diferenciales.

• Diferencial de código – donde el receptor Rover 
calcula la coordenada relativa actual en el modo 
diferencial utilizando sólo pseudo-rangos.

• RTK flotante – donde el receptor Rover calcula las 
coordenadas relativas actuales en el modo diferencial 
utilizando tanto pseudo rangos como fases; sin 
embargo, con una solución flotante, la ambigüedad de 
fase no es un número entero fijo y en su lugar se utiliza 
el estimado “flotante”.

• RTK fijo – donde el receptor Rover calcula las 
coordenadas relativas actuales, con fijación de 
ambigüedad, en modo diferencial.
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El campo LQ refleja el estado de los mensajes diferenciales 
recibidos y contiene la siguiente información:

• Calidad del Data link en porcentaje

• Tiempo (en segundos) transcurrido desde el último 
mensaje recibido

• Número total de mensajes correctos recibidos

• Número total de mensajes corruptos recibidos

Si el receptor no está (por algún motivo) recibiendo 
correcciones diferenciales, o si no se ha configurado 
ninguno de los puertos para recibir correcciones 
diferenciales, el campo LQ estará vacío o tendrá esta 
apariencia: 100%(999,0000,0000).
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El presente capítulo describe los procedimientos operativos 
estándar del HiPer+:

• Usar la MINTER

• Descargar archivos HiPer+ a una computadora

• Eliminar archivos en el HiPer+

• Verificar y cargar los OAFs

• Gestionar la memoria del HiPer+

• Borrar la NVRAM

• Cambiar los modos del receptor

• Verificar y cargar el firmware
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Usar la MINTER
MINTER (Figura 4-1) es la INTERfaz Mínima de Topcon que se 
utiliza para desplegar y controlar la entrada y salida de datos.

Figura 4-1. MINTER

Tecla de Encendido
Al presionar la tecla de encendido el receptor se enciende y 
apaga.

LED de Estado
• Cuando el receptor se encuentra encendido y no rastrea 

satélites, el LED de ESTADO parpadeará rojo.

• Cuando el receptor rastrea satélites, el LED de ESTADO 
parpadeará una vez por cada satélite rastreado (verde para 
GPS, naranja para GLONASS).

Tecla de Reinicialización
Al presionar la tecla de reinicialización durante un segundo, 
generará:

• Una reinicialización manual del receptor.

Power key

FN key (function/recording)

REC (recording LED)

STAT (status LED) BATT (battery LED)

RX (modem LED)

Reset Key
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• Que el receptor salga del Modo Energía Cero y regrese al 
Modo Normal.

AVISO
Utilice este procedimiento únicamente si el 
receptor no responde a los comandos o no 
carga las baterías internas (se encuentra en el 
Modo Energía Cero).

Tecla FN y LED de Registro
Tabla 4-1 en la página 4-5 resumen las funciones de la tecla FN 
y los estados del LED de Registro. Vea “Parámetro Modo de la 
Tecla FN ” en la página 2-30 para obtener información 
relacionada con la configuración de los modos de la tecla FN.

• Al presionar la tecla FN durante menos de un segundo el 
receptor alternará entre modos diferentes de información 
(información normal y extendida), o entre los modos de 
post-procesamiento estático y dinámico dependiendo de la 
configuración del receptor.

Durante el primer segundo de presionar la tecla FN, el LED 
de Registro estará naranja:

• Al presionar la tecla FN durante más de un segundo y 
menos de cinco se iniciará/detendrá el registro de datos.

Durante el registro de datos, el LED REC está verde.

Si el LED REC está rojo, el receptor ha agotado la 
memoria, tiene un problema de hardware o contiene un 
OAF incorrecto (vea “Archivo de Opciones Autorizadas 
(OAF)” en la página 1-18 para obtener mayor información 
sobre los OAFs.

• El LED de Registro parpadea verde cada vez que los datos 
son transferidos a la memoria interna del receptor.
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Usted configura el intervalo de tiempo de registro de datos 
con su PC-CDU. Vea “Parámetro del Intervalo de Registro” 
en la página 2-27 para obtener información sobre la 
configuración de esta función.

Cada vez que apague o encienda el registro de datos, se 
abrirá un nuevo archivo o se anexará datos a un archivo 
particular. Vea “Parámetro Siempre Anexar al Archivo” en 
la página 2-28 y “Parámetro Modo de Creación de 
Archivos” en la página 2-28 para obtener información 
sobre cómo configurar esta función.

• Al presionar la tecla FN durante más de cinco y menos de 
ocho segundos hará que la velocidad de transferencia en 
baudios del puerto serial A sea 9600. Después de mantener 
presionada la tecla FN el LED de Registro se vuelve rojo).   
Suelte la tecla FN mientras el LED de Registro se encuentra 
rojo (en los próximos tres segundos)

Al presionar la tecla FN durante más de ocho segundos no 
sucede nada.

• Después de cargar un firmware nuevo o borrar la NVRAM 
del receptor, el receptor verificará su sistema de archivos 
internos.

Durante esta operación, el LED de Registro parpadeará 
naranja y no será posible acceder al sistema de archivos 
para aplicaciones CDU (Unidad de Pantalla de Control) o 
para el registro de datos. Esta operación podría requerir 
desde fracciones de segundo hasta varios minutos, 
dependiendo de las circunstancias y de la memoria interna.
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Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN LED REC Estado

Si el registro de datos está desactivado, y la tecla FN esta…

Sin presionar

Sin luz No se registran datos.

Parpadeo 
naranja

Prueba de sistema interno de archivos en 
progreso

Rojo No hay memoria libre, problema de hardware 
durante el registro de datos

Presionada 
durante < de 
1 segundo

Si el modo de la tecla FN se encuentra en el “control de modo 
de parpadeo de LED”

Naranja Liberar para cambiar al modo de información

Si el modo de la tecla FN se encuentra en el control de modo 
Ocupación”

Naranja Sin funciones.

Presionada 
durante 1–5 
segundos

Si el modo de la tecla FN se encuentra en “Control del modo 
de parpado del LED”

Verde Soltar para iniciar registro (modo de 
ocupación de post-procesamiento Cinemático 
o Estático)

Si el modo de la tecla FN se encuentra en “Control del modo 
de Ocupación”

Verde Soltar para iniciar registro (modo de 
ocupación de post-procesamiento cinemático o 
estático)

Presionada 
durante 5–8 
segundos

Rojo Soltar para hacer que la velocidad de 
transferencia del puerto serial A sea 9600 bps
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Presionada 
durante > de 
8 segundos

Sin luz Sin Funciones

Cuando el registro de datos está activado, y la tecla FN está…

Sin presionar

Roja Sin memoria libre, problema del hardware con 
el registro de datos.

Si el modo de la tecla FN se encuentra en “Control del modo 
de parpadeo del LED”

Verde Registro de datos iniciado (modo de ocupación 
de post-procesamiento indefinido)

Si el modo de la tecla FN se encuentra en el control de modo 
de Ocupación

Verde Registro de datos iniciado (modo de ocupación 
de post-procesamiento cinemático)

Naranja Registro de datos iniciado (modo de ocupación 
de post-procesamiento estático)

Presionada 
durante < de 
1 segundo

Si el modo de la tecla FN se encuentra en “control del modo 
de parpadeo del LED”

Naranja Soltar para cambiar el modo de información.

Si el modo de la tecla FN se encuentra en “control del modo 
de Ocupación”

Naranja Soltar para desplazarse entre los modos de 
post-procesamiento Estático y Cinemático.

Presionada 
durante 1–5 
segundos

Sin luz Soltar para detener el registro de datos.

Presionada 
durante 5–8 
segundos

Rojo Soltar para hacer que la velocidad de 
transferencia en baudios del Puerto serial A 
sea 96000.

Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN LED REC Estado
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LED de la Batería
El color del LED de la batería indica el nivel de carga de la 
batería interna del HiPer+:

• Verde – indica una carga de más del 85%.

• Naranja– indica una carga intermedia.

• Rojo– indica una carga de menos del 15%.

El patrón de parpadeos del LED de la batería también indica la 
fuente de energía.

• Luz sólida – Se está utilizando alimentación externa y las 
baterías no se están cargando.

• Parpadeo una vez por segundo – las baterías se están 
cargando.

• Parpadeo cada cinco segundos – el HiPer+ se está 
alimentando a través de las baterías internas.

• Sin parpadeo – el receptor se encuentra en el Modo Energía 
Cero o las baterías internas se han descargado 
completamente y ninguna fuente externa se encuentra 
conectada.

AVISO
Si las baterías internas se han descargado 
totalmente y si no se ha conectado ninguna 
fuente externa de energía, el receptor pasará al 
Modo Energía Cero para evitar que las baterías 
se descarguen excesivamente.

Presionada 
durante > 8 
segundos

Sin luz Sin función (registro de datos aún en estado 
activo).

Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN LED REC Estado
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LED del Módem
El color del LED del Módem indica si el módem está 
encendido, está recibiendo señales o está apagado.

• Sin luz – el módem está apagado.

• Verde – el módem está encendido, pero no está recibiendo 
señales.

• Naranja– el módem está recibiendo una señal.

Modos de Información
El HiPer+ tiene dos modos de información: Modo de 
Información Normal y Modo de Información Extendida (EIM).

Normal

En el modo normal, el LED de ESTADO indica el número 
de satélites rastreados y el estado de cálculo de la posición.

Modo de Información Extendida (EIM)

El Modo de Información Extendida se utiliza para probar el 
receptor. En este modo, el receptor continúa funcionando 
de manera habitual, pero el LED de ESTADO indica la 
siguiente información “extendida”:

• Delimitador – un doble parpadeo fácilmente 
distinguible que muestra el estado total de las pruebas 
realizadas en EIM. El color del LED de ESTADO para 
el delimitador se calcula a partir de los colores de otros 
parpadeos del LED de ESTADO.

–Naranja: al menos un parpadeo es naranja.

–Rojo: Sin parpadeos color naranja y al menos un 
parpadeo rojo.

–Verte: todos los demás casos.

• Datos suficientes para el cálculo de posición.
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• La relación GPS S/N es buena (vea Tabla 4-2).

• La relación GLONASS S/N es buena (vea Tabla 4-2).

• La desviación de la frecuencia del oscilador es de 
menos de tres ppm.

• La Varianza Allan del Oscilador es de más de 2.7e-10.

• El tiempo de rastreo continuo es de más de 15 minutos.

En EIM, el LED de ESTADO parpadea varias veces por 
ciclo. Cada parpadeo puede ser naranja, rojo o verde.

• Naranja– información para prueba no disponible.

• Verde – el receptor ha pasado la prueba.

• Rojo – el receptor ha fallado la prueba.

1. Para cambiar a EIM, presione y suelte rápidamente (un 
segundo o menos) la tecla FN en la MINTER.

2. Espere que el delimitador parpadee dos veces. Con un 
receptor, antena y condiciones de observación buenos, 
todos los parpadeos deben ser verdes antes de haber 
transcurrido 15 minutos del encendido.

• Verde – ok

• Naranja– esperar

• Rojo– algunas pruebas falladas

3. Para volver a normal, presione la tecla FN. 

Table 4-2. Relación “Buena” Señal a Ruido (S/N)

CA/L1 P/L1 P/L2

GPS 51 39 39

GLONASS 51 49 40
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Descargar archivos a una 
Computadora
Después de terminar el levantamiento, puede descargar sus archivos 
de levantamiento a una computadora para guardarlos, post-
procesarlos o tener una copia de seguridad. De igual forma, la 
memoria del HiPer+ conserva un número determinado de archivos e 
información, por lo que al descargar los archivos a su computadora 
se asegurará que ningún archivo se pierda.

Usted debería descargar archivos tan pronto como sea posible 
después de colectar datos en el lugar de la obra. El PC-CDU le 
ofrece un Administrador de Archivos para descargar archivos a su 
computadora y eliminar archivos del HiPer+.

1. Conecte su receptor y la computadora. Vea “Conectar el HiPer+ 
a una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.

Y

Habilite la negociación RTS/CTS (Figura 4-2 en 
la página 4-10).

Figura 4-2. Parámetros de Conexión – Negociación RTS/CTS
Topcon Manual de Instrucciones del HiPer+



Descargar archivos a una Computadora

4-11
2. Haga clic en File->File Manager (Figura 4-3).

Figura 4-3. File->File Manager

3. Haga clic en la pestaña Download path (ruta de Descarga) en 
el cuadro de diálogo File Manager (Administrador de Archivos) 
(Figura 4-4).

Figura 4-4. Encontrar Archivos para Descargar

4. Ubique y abra la carpeta en la que va a descargar y guardar 
archivos.

O

Digite un nombre de carpeta nuevo y haga clic en Create para 
crear una carpeta nueva en la que podrá descargar y guardar 
archivos. Abra esta carpeta nueva.

5. Seleccione la pestaña Download files.

6. Seleccione el(los) archivo(s) que quiera descargar (Figura 4-5 
en la página 4-12). 
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Para seleccionar varios archivos a la vez, mantenga presionada 
la tecla Shift y después haga clic en los archivos deseados para 
seleccionar varios archivos en desorden a la vez; o mantenga 
presionada la tecla Ctrl y haga clic en archivos individuales.

Figura 4-5. Descargar Archivos

7. Haga clic en el botón Download. Durante la descarga, los 
indicadores de estado despliegan junto a cada archivo 
(Figura 4-6 en la página 4-13).

• Indicador azul – archivo en cola esperando para ser descargado.

• Indicador rojo – el archivo está siendo descargado.

• Indicador verde – el archivo ha sido descargado 
satisfactoriamente.
Topcon Manual de Instrucciones del HiPer+



Descargar archivos a una Computadora

4-13
Figura 4-6. Descargar Archivos – Indicadores de Estado

8. Una vez terminada la descarga, haga clic en Exit en el cuadro 
de diálogo del Administrador de Archivos.

9. Continúe con las demás operaciones.

O

Haga clic en File->Disconnect, después File->Exit para salir 
del PC-CDU (Figura 4-7).

Figura 4-7. Hacer clic en Disconnect y después en Exit
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Eliminar Archivos 
Siga los siguientes pasos para eliminar archivos de su receptor. 

1. Conecte su receptor y la computadora. Vea “Conectar el HiPer+ 
a una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.

Y

Habilite la negociación RTS/CTS (Figura 4-8).

Figura 4-8. Parámetros de Conexión – Negociación RTS/CTS

2. Haga clic en File->File Manager (Figura 4-9).

Figura 4-9. File->Manager

3. En la pestaña Download files (Descargar archivos) o en la 
pestaña Current log files (Archivos de registro actuales), 
seleccione el(los) archivo(s) que desee eliminar (Figura 4-10 en 
la página 4-15). 
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Para seleccionar varios archivos a la vez, mantenga presionada 
la tecla Shift y haga clic en los archivos en desorden para 
seleccionar varios archivos a la vez; o mantenga presionada la 
tecla Ctrl y haga clic en archivos individuales.

Figura 4-10. Eliminar Archivos

4. Haga clic en Delete (Figura 4-10).

5. Haga clic en Yes en el cuadro de diálogo de confirmación de 
eliminación de archivos. Al hacerlo, eliminará los archivos 
seleccionados.

6. Haga clic en Exit en la pantalla del Administrador de Archivos.

7. Continua con otras operaciones.

O

Haga clic en File->Disconnect, y después en File->Exit para 
salir del PC-CDU (Figura 4-11 en la página 4-16).
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Figura 4-11. Haga clic en Disconnect y después en Exit

Verificando un OAF

PUNTA
Para obtener una lista completa de opciones y 
sus detalles, visite el sitio web de Topcon.

Usted puede verificar el estado de las opciones de su receptor y 
cargar un nuevo OAF, utilizando un cable RS232, una computadora 
y un PC-CDU. Consulte el Manual del Usuario del PC-CDU para 
obtener una descripción más completa del software del PC-CDU.

1. Conecte su receptor y su computadora. Vea “Conectar el 
HiPer+ a una Computadora” en la página 2-5 para obtener 
información sobre este procedimiento.

2. Haga clic en Tools->Receiver Options (Herramientas->
Opciones del Receptor) (Figura 4-12).

Figura 4-12. Tools->Receiver Options 
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La pantalla del Administrador de Opciones muestra 
(Figura 4-13 en la página 4-18) y contiene la siguiente 
información:

• Nombre de la opción – un nombre/descripción de la opción

• Actual – el estado actual de la opción

• Adquirido – si la opción ha sido adquirida o no

• Alquilada – si la opción ha sido alquilada o no.

• Fecha de expiración – la fecha en la que la opción será 
deshabilitada, de ser aplicable.

Debido a que las opciones pueden ser adquiridas y alquiladas, 
el estado “Actual” de la opción muestra el valor efectivo en ese 
momento. Los valores de la opción pueden ser:

• -1 o “-----” – la versión del firmware no soporta esta 
opción.

• 0 – la opción del receptor está deshabilitada.

• Entero positivo – la opción está habilitada.

• Si o no – la opción está habilitada o deshabilitada.
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Figura 4-13. Administrador de Opciones

3. Al terminar, haga clic en Exit en la pantalla del Administrador 
de Opciones, después haga clic en File->Disconnect para evitar 
conflictos con la gestión del puerto serial.
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Cargar un OAF
Los distribuidores de Topcon Positioning System ofrecen a sus 
clientes los archivos OAF. Si tiene alguna consulta relacionada con 
los OAF, envíe un correo electrónico a options@topconps.com. Por 
favor tenga el número de ID del receptor a la mano (vea “Verificar 
la Versión del Firmware” en la página 4-24).

1. Para cargar un OAF nuevo, siga los pasos uno y dos de 
“Verificando un OAF” en la página 4-16.

2. Haga clic en Load en el extreme inferior de la pantalla del 
Administrador de Opciones (vea Figura 4-13 en 
la página 4-18).

3. Vaya a la ubicación del nuevo Archivo Autorizado de 
Opciones. Los OAFs tienen extensiones .jpo o .tpo y son únicos 
para cada receptor (Figura 4-14).

Figura 4-14. Cargar un OAF

4. Seleccione el archivo apropiado y haga clic en Open 
(Figura 4-14). La nueva opción del receptor se carga en el 
receptor y el cuadro Option Manager (Administrador de 
Opciones) se actualiza.

5. Al terminar, haga clic en Exit en la pantalla Option Manager, 
después haga clic en File->Disconnect para evitar conflictos 
con la gestión del puerto serial.
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Manejar la Memoria del HiPer+
Al usar el HiPer+ en aplicaciones estáticas o dinámicas, tal vez 
necesite conocer el nivel de memoria que el archivo de registro del 
receptor ocupa.   Este tamaño específico de memoria depende del 
tipo de datos que estén registrándose. Utilice las siguientes 
fórmulas para calcular el tamaño aproximado de los archivos de 
registro del receptor. 

• SS – el tamaño estimado de una época de datos sin procesar en 
el archivo de registro del receptor (expresado en bytes).

• N – el número de satélites observados por época.

Al registrar únicamente datos L1:

SS = 183 + 22*N

Al registrar datos L1 y L2: 

SS = 230 + 44*N

Borrar la NVRAM
La Memoria de Acceso Aleatorio No Volátil (NVRAM) del 
receptor conserva los datos requeridos para rastrear satélites, tales 
como efemérides de datos y posición del receptor. La NVRAM 
también mantiene las configuraciones actuales del receptor, como 
información de la antena activa, máscaras de elevación e intervalo 
de registro, e información sobre el sistema de archivos internos del 
receptor.

Aún cuando borrar la NVRAM no es constituye una operación 
común (ni tampoco se recomienda), algunas veces al borrar la 
NVRAM es posible eliminar problemas de comunicación o rastreo. 
Borrar la NVRAM en su HiPer+ puede interpretarse como un 
“arranque suave” en su computadora.

Las versiones 2.2p1 del firmware o superiores mantienen el módem 
PDL encendido después de borrar la NVRAM.
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Después de borrar la NVRAM, su receptor requerirá algo de tiempo 
para colectar nuevos efemérides y almanaques (aproximadamente 
15 minutos).

Al borrar la NVRAM de su receptor no eliminará ningún archivo 
que se encuentre guardado en la memoria de su receptor. Sin 
embargo, su receptor volverá a tener los valores establecidos en 
fábrica.

Además, la NVRAM se utiliza para conservar información sobre el 
sistema de archivos del receptor. Note que después de borrar la 
NVRAM, el LED de ESTADO del receptor parpadeará naranja 
durante algunos segundos indicando que el receptor está analizando 
y verificando el sistema de archivos.

Usted puede borrar la NVRAM utilizando la MINTER o el 
PC-CDU.

Usar la MINTER para Borrar la NVRAM
1. Presione la tecla de encendido para apagar el receptor.

2. Presione y mantenga presionada la tecla FN.

3. Presione y mantenga presionada la tecla de encendido 
durante aproximadamente un Segundo. Suelte la tecla de 
encendido mientras continúa presionando la tecla FN.

4. Espere hasta que los LEDS de ESTADO y REGISTRO 
estén verdes.

5. Espere hasta que los LEDs de ESTADO y REGISTRO 
parpadeen naranja.

6. Suelte la tecla FN mientras que los LEDS de ESTADO y 
REGISTRO parpadean naranja.
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Usar el PC-CDU para Borrar la NVRAM
1. Conecte su receptor y computadora. Vea “Conectar el 

HiPer+ a una Computadora” en la página 2-5 para obtener 
información sobre este procedimiento.

2. Haga clic en Tools->Clear NVRAM (Figura 4-15). El 
LED de REGISTRO rápidamente oscila verde y rojo; el 
LED de ESTADO oscila rojo.

Figura 4-15. Herramientas->Borrar NVRAM

El receptor automáticamente se desconecta una vez borrada la 
NVRAM.

Cambiar los Modos del Receptor
El receptor HiPer+ presenta cuatro modos, dos modos de 
información y dos modos de energía:

• Modo Normal

• Modo de Información Extendida

• Modo Sleep

• Modo Energía Cero

Vea “Modos de Información” en la página 4-8 para obtener una 
descripción del Modo Normal y del Modo de Información 
Extendida.

Modo Sleep (De Espera)
En el modo sleep, el tablero de energía y el módulo Bluetooth 
continúan consumiendo energía de las baterías, haciendo que, a 
la larga, las baterías se descarguen. Ponga el receptor en el 
Modo Energía Cero para evitar esta situación (vea “Modo 
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Energía Cero ” en la página 4-23). Siga estos pasos para poner 
el HiPer+ en el modo sleep.

1. Encienda su receptor.

2. Presione la tecla de encendido del receptor durante más de 
cuatro y menos de ocho segundos.  El LED de ESTADO 
estará naranja.  El receptor entra en el Modo Sleep.

3. Cualquier actividad en el puerto RS232 encenderá el 
receptor.

AVISO
Si presiona la tecla de encendido durante más 
de 14 segundos, no ocurrirá cambio alguno. 
Esto protege al receptor de las teclas trabadas.

Modo Energía Cero 
Si su HiPer+ se encuentra apagado, o incluso en el Modo Sleep, 
el tablero de energía continuará consumiendo energía de las 
baterías. Esto significa que si carga totalmente su receptor, lo 
apaga y lo guarda, el receptor consumirá la energía de la batería 
en menos de dos meses. Para evitar que el tablero de energía y 
el módulo Bluetooth consuman las baterías, ponga el receptor 
en el Modo Energía Cero.

1. Encienda su receptor.

2. Presione y mantenga presionada la tecla de encendido 
durante 8 segundos, pero menos de 14 segundos.

3. Suelte la tecla de encendido cuando ambos LEDs estén 
rojos. Cuando se apaguen los LEDS, su receptor estará en 
el Modo Energía Cero.

4. Presione la tecla Reset durante un segundo para regresar al 
modo Normal.
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AVISO
Cuando las baterías internas se hayan 
descargado completamente y no se haya 
conectado energía externa, el receptor irá 
automáticamente al Modo Energía Cero para 
evitar que las baterías se descarguen 
excesivamente.

Verificar la Versión del Firmware
Usted puede utilizar el PC-CDU para verificar la versión del 
firmware de su receptor. 

AVISO
El receptor HiPer+ debe cargarse con un 
firmware versión 2.3p1 o superior. 

PRECAUCIÓN
No utilice versiones de firmware 2.3 o más 
antiguas.

1. Conecte su receptor y computadora. Vea “Conectar el HiPer+ a 
una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.

2. Haga clic en Help->About (Figura 4-16).

Figura 4-16. Ayuda->Acerca de
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Se abre el cuadro de diálogo About PC-CDU (Figura 4-17).

Figura 4-17. Acerca del PC-CDU

About PC-CDU ofrece información importante sobre los 
diferentes accesorios y propiedades de diferentes hardware y 
software. La lista incluye lo siguiente, que necesitará si se 
contacta con TPS o su distribuidor:

• Modelo de receptor

• ID del receptor

• Versión de firmware

3. Al terminar, haga clic en OK, después haga clic en 
File->Disconnect para evitar conflictos con la gestión del 
puerto serial.
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Cargar un Firmware Nuevo
Los receptores Base y Rover deben ser cargados con la misma 
versión de firmware. Utilice la última versión de firmware más 
reciente, la cual puede ser descargada del sitio web de TPS, para 
asegurar que su receptor tenga acceso a las actualizaciones más 
recientes.

La tarjeta del receptor y el tablero de energía deben cargarse con el 
firmware del mismo paquete. El firmware del modulo Bluetooth es 
independiente de la tarjeta del receptor y del tablero de energía y 
tiene un paquete de firmware diferente.

El HiPer+ utiliza FLoader, un utilitario basado en Windows®, para 
cargar el firmware en los tableros del receptor y de energía. Usted 
puede descargar FLoader a su computadora en el sitio web de TPS. 
Para obtener más información, consulte el Manual del Usuario del 
FLoader, también disponible en el sitio web de TPS.

1. Descargue e instale FLoader, en caso de ser aplicable.

2. Descargue y descomprima el(los) nuevo(s) paquete(s) de 
firmware a su computadora.

3. Conecte su receptor y la computadora. Vea “Conectar el HiPer+ 
a una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.
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4. Active FLoader (Figura 4-18).

Figura 4-18. Pantalla Principal del FLoader

5. En la pestaña Connection, seleccione el puerto de 
comunicación en su computadora que se conecta con su 
receptor y seleccione su velocidad (generalmente es 115200) 
(Figura 4-18).

Vea las siguientes secciones para cargar el firmware apropiado.

Firmware del Receptor y del Tablero de 
Energía
El firmware del receptor y del tablero de energía viene como un 
archivo comprimido que usted descarga y descomprime. Este 
archivo contiene los tres archivos siguientes:

• ramimage.ldr – el archivo RMA de la tarjeta del receptor

• main.ldp – el archivo Flash de la tarjeta del receptor

• powbrd.ldr – el archivo RAM del tablero de energía

AVISO
Usted debe cargar los tres archivos al cargar su 
firmware nuevo. Estos archivos deben venir en el 
mismo paquete de firmware.
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1. En FLoader, seleccione la pestaña Device tab y defina 
Device Type as Receiver (Figura 4-19).

Figura 4-19. Obtener Tipo de Dispositivo

2. Haga clic en Get from Device para obtener información 
sobre el dispositivo (Figura 4-19).

3. Seleccione la pestaña Program y defina el Método de 
Captura a Break Capture (recomendado) (Figura 4-20).

Figura 4-20. Configuraciones de la Pestaña Program

4. Busque y seleccione el archivo RAM de la tarjeta del 
receptor y archivo Flash (Figura 4-20).
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5. Haga clic en Load y espere a que el 100% de los archivos 
se cargue en su receptor.

AVISO
Si selecciona un RAM o archivo Flash incorrecto, 
aparecerá un mensaje de error en el extreme 
inferior del cuadro de diálogo. Vuelva a 
seleccionar el archivo correcto.

6. Seleccione la pestaña Device y defina el Device Type (Tipo 
de Dispositivo) como Receiver’s Power Board (Tablero de 
Energía del Receptor) (Figura 4-21).

Figura 4-21. Definir Tipo de Dispositivo

7. Haga clic en Get from Device para obtener información 
sobre el dispositivo (Figura 4-21).
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8. Seleccione la pestaña Program y defina el Método de 
Captura a Soft Break Capture (recomendado) 
(Figura 4-22).

Figura 4-22. Configuraciones de la Pestaña Program

9. Busque y seleccione el archivo RAM del tablero de Energía 
(Figura 4-22).

10. Haga clic en Load y espere hasta que el 100% del archivo 
del tablero de energía se cargue en su receptor.

AVISO
Si selecciona un archivo RAM incorrecto, 
aparecerá un mensaje de error en el margen 
inferior del cuadro de diálogo. Vuelva a 
seleccionar el archivo correcto.

11. Haga clic en File->Exit.

12. Borrar la NVRAM del receptor (vea “Borrar la NVRAM” 
en la página 4-20) y actualice el almanaque (vea 
“Colectando Almanaques” en la página 2-52) después de 
cargar el nuevo firmware.
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Firmware del Módulo Bluetooth
El firmware del modulo Bluetooth viene como un archivo 
comprimido que usted descarga y descomprime. Este archivo 
contiene dos archivos:

• btloader.ldr – el archivo RAM del módulo Bluetooth

• btmain.ldp – el archivo Flash del módulo Bluetooth

AVISO
Usted debe cargar ambos archivos al cargar el 
firmware nuevo. Estos archivos deben venir en el 
mismo paquete de firmware.

1. En FLoader, seleccione la pestaña Device y defina el 
Device Type (Tipo de Dispositivo) como Receiver 
(Figura 4-23).

Figura 4-23. Obtener Tipo de Dispositivo

2. Haga clic en Get from Device para obtener información 
sobre el dispositivo (Figura 4-23).
P/N 7010-0526-SP www.topconpositioning.com



Operación

4-32
3. Seleccione la pestaña Program y defina el Capture Method 
(Método de Captura) a Soft Break Capture (recomendado) 
(Figura 4-24).

Figura 4-24. Configuraciones de la Pestaña Program 

4. Busque y seleccione el archivo RAM del archivo RAM y 
del archivo Flash del modulo Bluetooth (Figura 4-24).

5. Haga clic en Load y espere hasta que el 100% de los 
archivos se carguen en su receptor (Figura 4-25).

Figura 4-25. Carga Completa del Firmware de Bluetooth
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AVISO
Si selecciona un RAM o archivo Flash 
incorrectos, verá un mensaje de error en el 
margen inferior del cuadro de diálogo. Vuelva a 
seleccionar el archivo correcto.

6. Haga clic en File->Exit.
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Apuntes:
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Capítulo 5

P/N
Detección y Solución 
de Fallas
5-1
Mientras siga las instrucciones de mantenimiento y seguridad 
proporcionadas en el presente manual, tendrá, por lo general, pocos 
problemas con su HiPer+. Este capítulo le ayudará a diagnosticar y 
solucionar algunos problemas comunes que pudieran presentarse al 
operar su receptor HiPer+.

Antes de comunicarse con el Servicio de Soporte al Cliente de TPS 
por cualquier problema con el receptor, intente lo siguiente:

• Vuelva a configurar el receptor utilizando PC-CDU (haga clic 
en Tools->Reset receiver).

• Restablezca las configuraciones por defecto de fábrica 
utilizando PC-CDU (haga clic sobre Configuration
->Receiver, luego en Set all parameters to defaults).

• Borre la NVRAM (vea “Borrar la NVRAM” en 
la página 4-20).

• Inicialice el sistema de archivo (haga clic en Tools->Initialize 
file system; al hacerlo eliminará todos los archivos dentro del 
receptor).

ADVERTENCIA
No trate de reparar el equipo usted mismo. Al 
hacerlo invalidará su garantía y podría dañar 
el hardware. 
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Problemas de Energía 
Todos los receptores HiPer+ se preconfiguran en fábrica como 
“Modo Automático”, tanto para la energía como para el cargador. 
Si desea verificar estas configuraciones, 

1. Conecte su receptor y su computadora y ejecute el PC-CDU 
(vea “Conectar el HiPer+ a una Computadora” en 
la página 2-5).

2. Una vez conectados, haga clic en Configuration->Receiver. 

3. En la pestaña General, visualice los campos de Energía y del 
Cargador. 

Estos campos deben estar configurados en el Modo 
Automático. En caso contrario, cámbielos a Auto y haga clic en 
Apply.

PUNTA
Al borrar la NVRAM hará que el receptor regrese 
al Modo Automático (vea “Borrar la NVRAM” en 
la página 4-20).

Problema

El receptor no se enciende.

Causas Soluciones

El receptor puede estar 
en el Modo Energía 
Cero.

Presione la tecla de Inicialización. 

Si no se utiliza una 
fuente externa de 
energía, las baterías 
pueden descargarse. 

Conecte una fuente externa de energía 
totalmente cargada e intente de nuevo. 
Vea “Cargar el HiPer+” en 
la página 2-2.
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Problemas del Receptor 
Los siguientes son algunos de los problemas más comunes que 
puede presentar el receptor.

El receptor tiene una 
fuente externa de 
energía, pero las 
baterías internas están 
descargadas. 

Cargue las baterías durante la noche. 
Vea “Cargar el HiPer+” en 
la página 2-2.

El receptor puede tener 
un cargador defectuoso 
o baterías internas 
defectuosas. 

Si después de cargar sus baterías 
internas durante la noche aún no es 
posible encender el HiPer+, 
comuníquese con el Servicio de Soporte 
al Cliente TPS. 

Problema

El receptor no puede establecer una conexión con una 
computadora o con un controlador externo.

Causas Soluciones

Se ha deshabilitado el 
puerto B del receptor, 
impidiendo la 
comunicación 
inalámbrica entre el 
HiPer+ y un dispositivo 
externo habilitado 
Bluetooth.

1. Conecte su receptor y una 
computadora utilizando un cable 
RS232 (vea “Establecer una 
Conexión con un Cable RS232” en 
la página 2-7).

2. Haga clic sobre Configuration
->Receiver->General.

3. En el área de Slots Activar/
Desactivar, habilite la casilla de 
verificación del Slot 3 (B). 

El modo Cadena 
todavía está activo. 

Vea el Paso 14 en la página 2-41 sobre 
el procedimiento para desactivar la 
Cadena.
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El cable no está 
enchufado 
correctamente.

• Verifique que el conector del cable se 
encuentre en el puerto serial 
correspondiente. 

• Desenchufe el cable, luego vuelva a 
conectarlo correctamente al receptor. 

• Vea“Componentes Externos” en la 
página 1-15 y “Especificaciones del 
Conector” en la página B-10 para 
obtener información sobre los 
conectores del receptor.

El cable está dañado. • Utilice un cable en buen estado.

• Comuníquese con su Proveedor para 
adquirir cables nuevos. 

El puerto del receptor 
que se utiliza para la 
conexión no está en el 
modo Comando. 

1. Conecte su receptor y una 
computadora utilizando un Puerto 
libre (vea“Conectar el HiPer+ a una 
Computadora” en la página 2-5) e 
inicie el PC-CDU.

2. Haga clic en Configuration
->Receiver->Ports.

3. Cambie la Entrada para el puerto 
serial utilizado para la conexión a 
Comando. 

Problema

El receptor no captura los satélites durante un largo período de 
tiempo. 

Causas Soluciones

El receptor almacena 
un almanaque antiguo.

• Actualizar el almanaque.

• Vea “Colectando Almanaques” en la 
página 2-52.
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El cable de la antena 
está dañado. 

• Utilice un cable en buen estado.

• Contáctese con su Proveedor para 
adquirir cables nuevos. 

Problema

El receptor también rastrea algunos satélites. 

Causas Soluciones

El valor de la máscara 
de elevación es 
demasiado alto (por 
ejemplo, por encima de 
15 grados).

• Disminuir la mascara de elevación.

• Vea la página 2-27 para obtener 
información sobre la configuración de 
la máscara de elevación.

El levantamiento se 
realiza cerca de 
obstáculos (copa de 
árboles, edificios altos, 
etc.)

• Verifique que las casillas de 
Reducción Multípaso estén 
habilitadas. 

1. Conecte su receptor y una 
computadora e inicie el PC-
CDU. Vea “Conectar el HiPer+ 
a una Computadora” en la 
página 2-5.

2. Haga clic en Configuration
->Advanced->Multipath 
Reduction y habilite las dos 
casillas.

• Vaya a un área libre de obstáculos.
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Problema

El receptor no puede obtener el Código Diferencial y/o las 
soluciones RTK.

Causas Soluciones

Se ha elegido un estado 
incorrecto del receptor. 

• Elija el estado correcto del receptor. 

1. Conecte su receptor y una 
computadora e inicie el PC-
CDU. Vea “Conectar el HiPer+ 
a una Computadora” en la 
página 2-5.

2. Haga clic sobre Configuration
->Base o Configuration
->Rover y asegúrese que el 
receptor esté en el estado 
correcto (cinemático, RTK, o 
estático)

• Para mayor información, vea 
“Levantamiento con el HiPer+” en la 
página 3-6.

Las opciones 
correspondientes del 
receptor pueden estar 
desactivadas o haber 
expirado.

• Vea “Verificando un OAF” en la 
página 4-16 para obtener los detalles 
sobre cómo verificar las opciones 
actuales. 

• Habilite las opciones 
correspondientes del receptor. 

• Comuníquese con su proveedor para 
adquirir las opciones actuales del 
receptor. 
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No hay suficientes 
satélites comunes. Para 
obtener una solución 
fija, Base y Rover 
deberán rastrear por los 
menos cinco satélites 
comunes. 

• Asegúrese que los receptores Rover y 
Base utilicen el mismo almanaque, y 
que éste se encuentre actualizado, Vea 
“Colectando Almanaques” en la 
página 2-52.

• Verifique que las máscaras de 
elevación de los receptores Rover y 
Base; deben ser las mismas. Vea la 
página 2-27 para obtener información 
sobre la configuración de la máscara 
de elevación. 

Geometría satelital 
deficiente (los valores 
PDOP/GDOP son 
demasiado altos).

Lleve a cabo el levantamiento cuando 
los valores PDOP sean bajos. 

La máscara de 
elevación está por 
encima de los 15 
grados. 

• Disminuya la máscara de elevación. 

• Vea la página 2-27 para obtener 
información sobre la configuración de 
la máscara de elevación. 

El receptor y la antena 
tienen una conexión 
deficiente.

• Asegúrese que el cable esté en buenas 
condiciones. 

• Verifique el accesorio del conector 
del cable para el receptor. Retire y 
coloque nuevamente el conector del 
cable para garantizar una conexión 
segura. 

Los módems Base y 
Rover están 
configurados para los 
diferentes radio 
canales. 

• Configure los receptores Base y 
Rover para el mismo radio canal. 

• Vea “Configuración del Radio” en la 
página 2-33.
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Existe una discrepancia 
entre los estándares 
diferenciales utilizados 
en los receptores Base 
y Rover. 

Asegúrese que los receptores Base y 
Rover utilicen el mismo formato de 
correcciones de entrada/salida: 

1. Conecte su receptor y una 
computadora e inicie el PC-
CDU. Vea “Conectar el HiPer+ 
a una Computadora” en la 
página 2-5.

2. Haga clic en Configuration
->Receiver->Ports y configure 
el mismo formato de entrada/
salida para ambos receptores.

La velocidad específica 
de enlace no es 
compatible con las 
velocidades de enlace 
que el módem soporta. 

La velocidad de enlace 
es la velocidad en la 
que se transmiten los 
datos sobre el enlace de 
RF.

• Cambie la velocidad de enlace por la 
velocidad que su módem soporta. Vea 
el manual del módem para obtener 
información sobre la velocidad de 
enlace soportada. 

• Vea “Configuración del Radio” en la 
página 2-33 para verificar la 
velocidad actual de enlace y cambiar 
la velocidad de enlace. 
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La velocidad específica 
de transferencia en 
baudios no es 
compatible con las 
velocidades en baudios 
soportadas por el 
módem. 

La velocidad de 
transferencia en 
baudios es la velocidad 
con la que el receptor 
transmite los mensajes 
diferenciales al módem 
y viceversa.

• Cambie la velocidad en baudios por la 
velocidad que su módem soporta. Vea 
el manual del módem para obtener 
información la velocidad en baudios 
soportada.

• Vea “Configuración del Radio” en la 
página 2-33 para verificar la 
velocidad actual en baudios y cambiar 
la misma.

El control Digisquelch 
en el módem de 
transmisión está 
configurado 
incorrectamente. 

El control Digisquelch en el módem de 
transmisión deberá estar en On 
(Encendido) y configurado en Low 
(Bajo). 

El control Digisquelch 
en el módem de 
recepción está 
configurado 
incorrectamente. 

El control Digisquelch en el módem de 
recepción deberá estar en On 
(Encendido) y configurado en Médium 
(Medio) o High (Alto).

La batería del módem 
está baja.

• Conecte una fuente externa de energía 
al receptor. Vea “Baterías Externas” 
en la página 2-3.

• Vea “Cargar el HiPer+” en la 
página 2-2.

Mala calidad de ancho 
de banda (un alto 
número de señales de 
interferencia).

Utilice otro canal de frecuencia para los 
módems Base y Receptor.
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La distancia entre Base 
y Rover es demasiado 
grande. 

• Acorte la distancia entre Base y 
Rover. 

• Utilice una repetidora de radio.

Problema

El receptor no inicia el registro de datos.

Causas Soluciones

El receptor no tiene 
espacio libre para los 
archivos. 

• Descargue los archivos del receptor a 
una computadora (en caso de ser 
necesario) y borre los archivos (vea 
“Descargar archivos a una 
Computadora” en la página 4-10 y 
“Eliminar Archivos ” en 
la página 4-14).

• Utilice la característica AFRM. Vea 
“Parámetros del Modo Automático de 
Rotación de Archivos (AFRM) ” en la 
página 2-28.

El receptor ya ha 
registrado 256 archivos 
en la memoria interna. 

• Borre los archivos innecesarios (vea 
“Eliminar Archivos ” en 
la página 4-14)

• Utilice la característica AFRM. Vea 
“Parámetros del Modo Automático de 
Rotación de Archivos (AFRM) ” en la 
página 2-28.
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Problemas Bluetooth 
Los siguientes son algunos de los mensajes de error comúnmente 
encontrados. BTCONF reporta los mensajes de error en la barra de 
estado.

Mensaje de Error 

No puede encontrar al receptor.

Causas Soluciones

El receptor está 
apagado.

Asegúrese que el receptor esté cargado y 
se encuentre encendido. 

Los conectores del 
cable han sido 
conectados 
incorrectamente. 

• Verifique que el conector del cable se 
encuentre conectado al puerto serial 
correcto.

• Desenchufe el cable, luego vuelva a 
conectarlo correctamente al receptor.

El cable está dañado. • Utilice un cable en buen estado.

• Comuníquese con su Proveedor para 
adquirir un cable nuevo. 

El puerto COM al que 
está conectado el 
receptor es diferente al 
seleccionado en 
BTCONF.

Asegúrese que el cable RS232 esté 
conectado al Puerto COM especificado 
en la lista despegable del puerto de 
comunicación BTCONF. Vea 
“Configuración del Módulo Bluetooth” 
en la página 2-46 para obtener mayores 
detalles.
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El puerto del receptor 
utilizado para la 
conexión no está en el 
modo Comando. 

1. Conecte su receptor y una 
computadora utilizando un puerto 
libre (vea “Conectar el HiPer+ a una 
Computadora” en la página 2-5) e 
inicie el PC-CDU.

2. Haga clic en Configuration
->Receiver->Ports.

3. Cambie la Entrada para el puerto 
serial utilizado para la conexión a 
Comando. 

Las configuraciones 
para el Puerto B 
pueden haber 
cambiado.

• Las configuraciones para el Puerto B 
son: velocidad de transferencia en 
baudios de 115200, 8 bits de datos, 1 
bit de parada, sin paridad, y sin 
negociación.

• Intente habilitar la negociación RTS/
CTS para el Puerto B. No cambie las 
demás configuraciones.

Las opciones 
correspondientes del 
receptor pueden estar 
desactivadas o haber 
expirado.

• Vea “Verificando un OAF” en la 
página 4-16 para obtener detalles 
sobre cómo verificar las opciones 
actuales. 

• Habilite las opciones correspondientes 
del receptor. 

• Comuníquese con su proveedor para 
adquirir las opciones actuales del 
receptor.
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Mensaje de Error 

No es posible encontrar el Bluetooth.

Causas Solución

El Slot 3 del receptor 
se encuentra 
desactivado. 

1. Conecte su receptor y una 
computadora utilizando un cable 
RS232 (vea “Establecer una 
Conexión con un Cable RS232” en 
la página 2-7).

2. Haga clic sobre Configuration
->Receiver->General.

3. En el área de Activar/Desactivar 
Slots habilite la casilla de 
verificación del Slot 3 (B). 

El módulo Bluetooth 
se encuentra vinculado 
a otro dispositivo.

Cierre la conexión con el dispositivo, 
luego conéctelo a su receptor. 

El procesador del 
módulo Bluetooth se 
encuentra 
sobrecargado.

1. Coloque su receptor en el Modo 
Energía Cero. Vea “Modo Energía 
Cero ” en la página 4-23 para 
obtener mayores detalles.

2. Presione la tecla Reset durante 
aproximadamente un segundo para 
que el receptor vuelva al modo 
normal. 

3. Vuelva a conectarse al módulo 
Bluetooth.

El receptor no tiene un 
módulo Bluetooth.

Comuníquese con su proveedor para 
adquirir un receptor con Bluetooth 
habilitado.
P/N 7010-0526-SP www.topconpositioning.com



Detección y Solución de Fallas

5-14
Mensaje de Error 

No se puede abrir el Puerto COM#: Acceso denegado

Causas Solución

Es posible que otra 
aplicación se encuentre 
utilizando el puerto de 
la computadora 
dedicado a la 
conexión.

• Cierre la aplicación, luego vuelva a 
conectarse.

• Conecte el receptor mediante otro 
puerto de la computadora que no esté 
en uso.

Problema

Después de buscar dispositivos disponibles, no encuentra 
ninguno. 

Causas Solución

El receptor no está 
recibiendo energía.

• Verifique que el receptor esté 
recibiendo energía y esté encendido

• Verifique que el cable de alimentación 
se encuentre conectado al puerto serial 
correcto. 

• Desenchufe el cable, luego vuelva a 
conectarlo correctamente al receptor.

• Si el cable de alimentación se 
encuentra dañado, comuníquese con 
su Proveedor para adquirir un cable 
nuevo.
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El Slot 3 del receptor 
se encuentra 
desactivado. 

1. Conecte su receptor y una 
computadora utilizando un cable 
RS232 (vea “Establecer una 
Conexión con un Cable RS232” en 
la página 2-7).

2. Haga clic en Configuration
->Receiver->General.

3. En el área de Activar/Desactivar 
Slots habilite la casilla de 
verificación del Slot 3 (B).

Los dispositivos 
pueden estar fuera del 
alcance aceptable del 
radio. 

• Verifique que sus dispositivos se 
encuentren dentro del alcance 
aceptable del radio.

• Coloque los dispositivos dentro del 
alcance de radio. 

Problema

Puede ver el icono del módulo Bluetooth del receptor en la 
pantalla de la computadora, pero no puede conectarse. 

Causas Solución

Las configuraciones de 
seguridad del 
dispositivo 
probablemente sean 
diferentes. 

• Asegúrese que sus dispositivos 
habilitados en Bluetooth utilicen las 
mismas configuraciones de seguridad.

• Vea “Configuración del Módulo 
Bluetooth” en la página 2-46, 
específicamente la Figura 2-44 en la 
página 2-51 para obtener mayores 
detalles sobre cómo cambiar las 
configuraciones de seguridad. 
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Las configuraciones 
del módulo Bluetooth 
pueden haber 
cambiado. 

1. Si cambia las configuraciones de su 
módulo Bluetooth, elimínelo de la 
lista de los dispositivos Bluetooth 
encontrados utilizando el programa 
administrador Bluetooth (que cuenta 
con el dispositivo utilizado para 
administrar el receptor).

2. Repita la búsqueda. 
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Apéndice A

P/N
Crear Archivos 
Script
A-1
Los archivos script le permiten guardar los comandos manuales en 
un archivo. Después puede cargar este código en lugar de digitar 
cada comando individual. Siga el siguiente procedimiento para 
crear scripts. 

PUNTA
Para obtener más información sobre los archivos 
script, revise el Manual del Usuario del PC-CDU.

1. Conecte su receptor y computadora. Vea “Conectar el HiPer+ a 
una Computadora” en la página 2-5 para obtener información 
sobre este procedimiento.

2. Inicie PC-CDU.

3. Haga clic en File->Manual Mode.

4. Haga clic en Edit script.

5. Ubique la carpeta en la que desea guardar el archivo script.

6. Digite el nombre del archivo. Todos los archivos tienen la 
extensión. jpc.

Por ejemplo, Daisy_38400.jpc para habilitar la conexión en 
cadena daisy chain y Daisy_Off.jpc para deshabilitar la cadena 
daisy.

7. Haga clic en Yes para crear el archivo.
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A-2
8. Digite los comandos apropiados, y presione Enter después de 
cada uno. Vea Tabla A-1 para obtener información sobre estos 
comandos.

9. Haga clic en Save script.

10. Haga clic en Close editor.

Una vez que ha creado un archivo script,

1. Haga clic en Load script en el cuadro de diálogo Manual 
Mode.

2. Ubique la carpeta que contenga su archivo script.

3. Seleccione el archivo script apropiado y haga clic en Open.

4. Presione Enter o haga clic en Send command para ejecutar el 
archivo script.

Tabla A-1. Comandos de Scripts

Para crear una Daisy Chain Para terminar una Daisy Chain

%%set,dev/ser/c/rate,38400
%%set,dev/ser/c/echo,/cur/term
%%set,dev/ser/c/imode,echo
%%set,cur/term/eoff,QUIT
%%set,cur/term/echo,/dev/null
%%set,cur/term/imode,echo
%%set,cur/term/echo,/dev/ser/c

QUIT
%%set,cur/term/imode,cmd
%%set,dev/ser/c/echo,/dev/null
%%set,dev/ser/c/imode,cmd
%%set,dev/ser/c/rate,38400
%%set,cur/term/rate,115200
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Apéndice B

P/N
Especificaciones
B-1
Este producto TPS es un GPS+ (GPS y GLONASS) de 40 canales 
con una antena interna, un radio UHF o GSM, un módulo de 
tecnología inalámbrica Bluetooth, y una carcasa de aluminio 
resistente completa con la MINTER y con conectores de cable.

Especificaciones del HiPer+
Tabla B-1 enumeran los detalles del componente HiPer+.

Table B-1. Especificaciones del HiPer+

Component Details

Tipo de receptor

Euro-112 GGD – definida activando el OAF 
correcto:

G – GPS L1
GD – GPS L1/L2
GG – GPS/GLONASS L1
GGD – GPS/GLONASS L1/L2

Especificaciones de Rastreo

Canales Estándar 20 L1 GPS, L1/L2 GPS, L1/L2 GLONASS, L1/L2 
GPS + L1/L2 GLONASS, WAAS/EGNOS

Opcional Días Cenicienta (vea la página B-9 para obtener 
detalles)

Señales Rastreadas L1/L2 C/A y Código P y Portadora, WAAS/EGNOS
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Modo de Levantamiento

Estático
Cinemático (Continuo, Parar y Seguir)
RTK (Cinemático en Tiempo Real)
DGPS (GPS Diferencial)

Precisión del Levantamiento

Estático, Estático 
Rápido

Para L1+L2 – H: 3mm + 1ppm x D; 
V: 5mm + 1.4ppm x D

Para L1 – H: 5mm + 1.4ppm x D; 
V: 7mm + 1.9ppm x D

Cinemático Para L1+ L2 – H: 10mm + 1.5ppm x D; 
V: 15mm + 2.0ppm x D

Para L1 – H: 15mm + 2.0ppm x D;
V: 20mm + 2.5ppm x D

RTK Para L1+ L2 – H: 10mm + 1.5ppm x D; 
V: 15mm + 2.0ppm x D

Para L1 – H: 15mm + 2.0ppm x D; 
V: 20mm + 2.5ppm x D

Arranque Frío
Arranque Cálido
Readquisición

< 60 seg
< 10 seg
< 1 seg

Tecnología

Rastreo Co-Op
Rastreo de señal baja
Mitigación avanzada multipath
WAAS
Parámetros ajustables PLL y DLL

Table B-1. Especificaciones del HiPer+

Component Details
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B-3
Radio Módem

Amplio Espectro Transceptor de Espectro Ensanchado interno de 915 
MHz o 2.4 GHz 

Radio módem UHF Tx/Rx interno o externo

Módem GSM Europa y Asia – 900/1800 MHz
EE.UU. y Canadá – 900/1900 MHz

Especificaciones del Módulo Bluetooth

Tipo Clase 2

Clases de servicios Misceláneos

Perfiles soportados LM, L2CAP, SDP, PPP

Código de Frecuencia 
del País

Norteamérica y Europa

Almacenamiento de Datos y Visualización

Indicadores de Estado Cuatro LEDs tres colores

Controles Tres teclas de función

Características de los Datos

Tasa de actualización de hasta 20 Hz para 
posicionamiento y datos crudos en tiempo real 
(código y portadora)
Fase de código de 10cm y precisión de la portadora 
de 0.1mm
Versión 2.1, 2.2, y 2.3 RTCM SC104 
Base RTCM Múltiple
Modelos de Variación Geoide y Magnética
RAIM
Soporte de diferentes DATUMs
Envío de coordenadas de cuadrícula
Soporte CMR y CMR+

Table B-1. Especificaciones del HiPer+

Component Details
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I/O

Puertos de 
Comunicación

Hasta cuatro puertos de serie RS232 y un puerto USB

Conectores Antena Módem, 1salida PPS (opcional), entrada de 
Marcador de Eventos (opcional), PWR, USB

MINTER Cuatro LEDs internos
Entrada de control ON/OFF

Antenna

Antena GPS/
GLONASS

Interna

Tipo de Antena Microstrip

Memoria

Memoria Interna Tarjeta flash compacta (no removible)

Capacidad Estándar – 0 MB 
Max – 1 G

Tiempo de Registro 53 horas (8 MB, 15seg, L1/L2, 7 satélites)

Intervalo de Registro 0.05 a 86400 segundos, dependiendo de las opciones 
adquiridas

Energía

Batería Interna Li-ion, 3000 mAh, 7.4 V

Tamaño de la Batería 132 x 35 x 18 (mm)

Peso de la Batería 165 g (1 batería)

Número de baterías 
internas

2 baterías

Batería de cambio Batería no descartable

Table B-1. Especificaciones del HiPer+

Component Details
Topcon Manual de Instrucciones del HiPer+



Especificaciones del HiPer+

B-5
Tiempo de Operación ~11.5 horas con Radio PDL UHF encendido
~13.5 horas con Radio PDL UHF apagado

Energía externa 1 puerto

Voltaje de entrada 6 a 28 V DC (para trabajo)
9 a 28 V DC (para la batería de carga) 
Corriente Mínima de Carga >=2 Amp

Consumo Normal: 2.5W
Máximo: 2.7W

Batería incorporada Batería de repuesto para sincronización y 
almacenamiento de datos de almanaque.
Funcionamiento mínimo de 10 años

Entorno

Temperatura operativa -30 C° a + 60 C° con baterías

Temperatura de 
almacenamiento

-40 C° a +75 C° con baterías

Características físicas

Carcasa Extrusión de aluminio, a prueba de lluvias

Color Amarillo Topcon

Dimensiones Ancho:158.5 x Alto:113 x Diámetro:173 mm

Peso 1.72 kg

Antena Interna

Batería Dos internas

Controlador Externo

Montaje 5/8-11

Sellos Silicio (moldeado en Color)

Table B-1. Especificaciones del HiPer+

Component Details
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Teclas Tres teclas:
Encendido/Apagado
Función (FN) – iniciar/detener registro de datos, 
cambiar modo de información.
Inicializar – inicialización del hardware del receptor

LEDs Cuatro LEDs:
ESTADO – estado del satélite y del receptor
REGISTRO – estado de registro y datos
BATERÍA – estado de la batería
RX – estado del módem

NMEA

Versión NMEA Salida Vea. 2.1, 2.2, 2.3, 3.0

Mensajes GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, 
RMC, VTG, ZDA, ROT

Intervalo de salida Estándar 1Hz; 5, 10, 20Hz opcional

DGPS

Formato de 
corrección

RTCM SC104 Vea 2.1, 2.2, y 2.3

Tipo de mensaje 
RTCM

1, 3, 9, 31, 32, 34; seleccionable por el usuario

Intervalo de proceso 1Hz estándar; opcional 5, 10, 20Hz 

Intervalo de salida 
para los datos de 
corrección RTCM

1Hz estándar; 5, 10, 20Hz opcional

Máscara de elevación 0 a 90 grados (independientemente del registro de 
datos)

DGPS Multibase Modo de selección de corrección diferencial: Más 
Cercano, Mixto, Mejor (opcional)

Table B-1. Especificaciones del HiPer+

Component Details
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RTK

Formato de 
corrección

CMR2/CMR+ (compatible con Trimble), RTCM 
SC104. Vea 2.2 o 2.3

Tipo de mensaje 
RTCM

3, 18, 19, 20, 21, 22; seleccionable por el usuario

RTK Inverso Estará disponible en el futuro

Inicialización de 
Ambigüedad

OTF (L1, L1/L2)

Longitud de la línea 
de base

Hasta 50km en la mañana y tarde.  Hasta 32 al 
mediodía.

Tiempo de 
inicialización

5 segundos a 10 min dependiendo de la longitud de la 
línea de base y de las condiciones multipath.

Intervalo de salida 
para CMR/RTCM

1Hz standard; 5, 10, 20Hz optional

Elevación 0 a 90 grados (independientemente del registro de 
datos)

Modo de solución Retardo (sincronización)
Extrapolación (no sincronizada)

Intervalo del proceso 1Hz estándar; 5, 10, 20Hz opcional

Latencia Modo de retardo – 20 mseg a 20 seg (depende de la 
latencia que recibe datos de corrección del receptor 
base) 
Extrapolación – 20 a 30 mseg

Registro de Datos sin 
Procesar

El receptor puede registrar datos sin procesar en otro 
intervalo durante la operación RTK

Estado Fijo, Flotante, DOP, Estado del Data Link, Latencia 
del Módem, Satélites comunes, Porcentaje de fijación

Table B-1. Especificaciones del HiPer+

Component Details
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Resultados Coordenadas RTK, HRMS, VRMS, Matriz de 
Covarianza

Nivel de fijación de 
ambigüedad

Umbrales seleccionables 
Bajo 95%; Medio: 99.5%; Alto: 99.9%

Salida PPS (opcional)

Número de puertos 
PPS

1

Borde Subida, Caída

Período 10 to 1000000000 ms

Desviación -500000000 a 500000000 mseg   
-500000 a 500000 nseg

Tiempo de referencia GPS, GLONASS, UTC (USNO), UTC (SU)

Marcador de Eventos (opcional)

Número de puertos 
del Marcador de 
Eventos

1

Borde Subida, Caída

Tiempo de referencia GPS, GLONASS, UTC (USNO), UTC (SU)

Funciones de Rastreo

Reducción Multi-path Código y Portadora

Configuración PLL/
DLL

Ancho de banda, orden, ajustable

Configuración del 
bucle de rastreo co-op

Encendido/Apagado, Modo Estático, Ancho de 
banda de PLL individual, Ancho de banda de PL 
común

Table B-1. Especificaciones del HiPer+

Component Details
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Los días Cenicienta es una opción que convierte una frecuencia 
simple (receptor GPS) en una doble frecuencia (receptor 
GPS+GLONASS) durante 24 horas cada dos martes a la 
medianoche GPS. Consulte el sitio web de Topcon para obtener 
más información y las fechas Cenicienta específicas.

AVISO
Las especificaciones de rendimiento asumen un 
mínimo de 6 satélites GPS o 7 GPS/GLONASS 
por encima de 15 grados de elevación y el 

Intervalo de 
Suavizamiento

Código y Portadora

WAAS/EGNOS Estándar

Cargador de Baterías (Adaptador AC)

Tamaño Ancho:60 x Largo:112 x Alto:36 mm

Peso 235 g

Temperatura 
Operativa

0 C° to +40 C°

Temperatura de 
almacenamiento

-40 C° to +85 C°

Entrada AC 90 a 264 V 1A (110 V AC) 
47 a 63 Hz

Salida DC 12 V 2.5 A (30 W)

Conector Entrada (AC): Toma
Salida (DC): Pin Fisher 5

Tiempo del cargador 
de baterías

7 horas para una Carga Completa
6 horas para una Carga del 90%

Table B-1. Especificaciones del HiPer+

Component Details
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cumplimiento de los procedimientos 
recomendados en el presente manual.

AVISO
En aquellas áreas de multipath alta, durante 
períodos de gran PDOP, y durante períodos de 
mayor actividad ionosférica, el rendimiento 
podría disminuir.

AVISO
Utilice los procedimientos de verificación 
robusta en áreas de multipath extrema o bajo 
follaje espeso.

Especificaciones del Conector
Esta sección lista los detalles del conector HiPer+.

Conector RF Radio (Módem)
El tipo de conector módem (UHF) de Pacific Crest (Tabla B-2) 
es un conector RF BNC Bulkhead Jack con un número de parte 
6501-7051-003 de Applied Engineering Product.

El módem de Espectro Ensanchado (TPS) o el tipo de conector 
de módem GSM (Table B-3 en la página B-11) es un conector 
TNC RF.

Tabla B-2. Especificaciones del Conector de Módem (UHF) PDL de Pacific 
Crest

Tipo Nombre de la Señal Dir Detalle

BNC Módem I/O I Entrada RF de la antena PDL
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Conector de Energía
El conector de energía (Figura B-1) es un receptáculo sellado, 
de 5 pines, número de parte ODU G80F1C-T05QF00-0000.

Figura B-1. Conector de Energía

Tabla B-4 le proporcionan las especificaciones del conector de 
energía.

Tabla B-3. Especificaciones del Conector del Módem de Espectro 
Ensanchado/GSM

Tipo Nombre de la Señal Dir Detalles

TNC Módem I/O I/O Entrada RF desde la antena del 
módem

Tabla B-4. Especificaciones del Conector de Energía

Número Nombre de la Señal Dir Detalles

1 Power_INP P Entrada DC de 6 a 28 voltios

2 Power_INP P Entrada DC de 6 a 28 voltios

3 Power_GND P Tierra, retorno de energía

4 Power_GND P Tierra, retorno de energía

5 No utilizado
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Conector de Serie C-RS232 
Para los puertos A y D. Los conectores RS232 (Tabla B-2) son 
un receptáculo sellado, de 7 pines, número de parte ODU 
G80F1C-T07QC00-0000.

Figura B-2. Conector RS232

Tabla B-5 le proporcionan las especificaciones del conector de 
cable RS232.

Table B-5. Especificaciones del Conector RS232

Número Nombre de la Señal Dir Detalles

1 Power_OUT P Salida de Energía (I<0.2 A)

2 GND - Tierra de la señal

3 CTS I Listo para Envío (Clear to 
send)

4 RTS O Solicitud de Envío (Request 
to send)

5 RXD I Recibir datos

6 TXD O Transmitir datos

7 No utilizado
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Conector USB
El conector USB es un receptáculo sellado, de 5 pines, número 
de parte ODU G80F1C-T05QF00-0000 (Figura B-3).

Figura B-3. Conector USB

Tabla B-6 le proporcionan las especificaciones del conector 
USB.

Table B-6. Especificaciones del Conector USB

Número Nombre de la Señal Dir Detalles

1 No utilizado

2 USB_PWR P Bus power

3 GND - Tierra

4 USB D+ I/O Data plus

5 USB D- I/O Data minus
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Apuntes:
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Apéndice C

P/N
Información de 
Seguridad
C-1
Precauciones Generales 

AVISO
Para cumplir con los requisitos de la exposición 
a la RF, mantenga por lo menos una distancia de 
20cm entre el usuario y el radio módem GSM. 

ADVERTENCIA
El HiPer+ ha sido diseñado para propósitos 
de levantamiento y aquellos que se 
relacionen con el levantamiento (es decir, el 
levantamiento de coordenadas, distancias, 
ángulos, profundidades, y el registro de tales 
mediciones). Este producto nunca se deberá 
utilizar:

– Si el usuario no ha comprendido a 
cabalidad el presente manual. 

– Después de desactivar los sistemas de 
seguridad o alterar este producto.

– Con accesorios no autorizados.
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– Si el sitio en el que se va a realizar el 
levantamiento no ofrece las garantías 
necesarias.

– En contra de las leyes, normas y 
regulaciones vigentes. 

PELIGRO

NO UTILICE EL HIPER+ EN AMBIENTES 
PELIGROSOS. SU USO EN LA LLUVIA O NIEVE ESTÁ 
PERMITIDO DURANTE UN TIEMPO LIMITADO. 

Advertencias sobre el Paquete Interno 
de Baterías 

PELIGRO

¡NUNCA TRATE DE ABRIR LA CUBIERTA DEL HIPER+ 
O DE REEMPLAZAR LAS BATERÍAS! EL USO 
INCORRECTO DE LAS BATERÍAS DE LITIO-ION PUEDE 
SER PELIGROSO!

PELIGRO

NO INCINERE O CALIENTE EL PAQUETE DE BATERÍAS 
POR ENCIMA DE LOS 212 GRADOS FAHRENHEIT (100 
GRADOS CELSIUS). EL CALOR EXCESIVO PUEDE 
OCASIONAR DAÑOS SERIOS Y UNA POSIBLE 
EXPLOSIÓN. 
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ADVERTENCIA
La manipulación de las baterías internas por 
parte de usuarios finales y/o técnicos no 
autorizados invalidará la garantía del 
receptor.

– No trate de abrir o reemplazar el paquete de 
baterías.

– No desarme el paquete de baterías.

– No cargue en condiciones contrarias a las 
especificadas.

– Sólo utilice el cargador de batería 
especificado.

– Evite cortocircuitos. 

– No comprima o modifique las baterías.

PRECAUCIÓN
Cuando enchufe el cable de alimentación/
cargador en un tomacorriente, utilice uno con 
conexión a tierra.
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Advertencias sobre el Uso 

PRECAUCIÓN
Si el producto ha sufrido una caída, alteración 
o ha sido transportado o embarcado sin el 
empaque apropiado, o si es sometido a un 
trato inadecuado, podría efectuar mediciones 
incorrectas. 

El propietario debe hacer evaluar 
periódicamente este producto para asegurar 
la obtención de mediciones precisas. 

Si este producto no funciona correctamente, 
informe inmediatamente a TPS.

PRECAUCIÓN
Este producto podrá ser revisado o reparado 
únicamente por los centros de servicio 
autorizados TPS.
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Uso del Radio UHF
D-1
AVISO
Muchos países exigen a los usuarios de radio 
una licencia (como es el caso de los Estados 
Unidos). Asegúrese de cumplir con todas las 
leyes locales cuando opere su radio UHF.

Los levantamientos en el modo RTK han hecho de la UHF la 
elección más popular para las comunicaciones entre los receptores 
Base y Rover. El usuario debe conocer las fortalezas y debilidades 
de esta tecnología para sacarle el máximo provecho a su receptor 
HiPer+.

La calidad y fuerza de las señales UHF se traduce en el alcance de 
sus comunicaciones UHF. Los siguientes conceptos lo ayudarán a 
aprovechar al máximo sus sistemas de comunicación basados en 
UHF:

1. El alcance de su sistema dependerá en gran medida de las 
condiciones locales.

A nivel topográfico, las comunicaciones locales e incluso las 
condiciones topográficas juegan un papel sumamente 
importante en el alcance potencial de sus comunicaciones RTK. 
Un radio base de 35 watts le permitirá al receptor alcanzar 
distancias de hasta 12 millas utilizando la antena estándar, 
dependiendo de las condiciones locales. Es sencillo alcanzar 
distancias en el orden de 4 a 7 millas (6 a 11 Km.).
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PUNTA
Utilice un escáner para encontrar canales 
limpios de comunicación.

2. El alcance de su sistema mejorará si ajusta la antena de su 
estación Base siguiendo algunas de las siguientes 
recomendaciones. 

• Asegúrese que la batería del radio Base se encuentre totalmente 
cargada.

• Use antenas direccionales y/o repetidoras para aumentar el 
alcance de su sistema. Las antenas direccionales concentrarán 
la fuerza de la señal en una dirección más definida, mejorando 
significativamente el alcance de su sistema. 

• Revise la línea de accesorios de TPS y encontrará diversos 
ítems que lo ayudarán a mejorar el alcance de su radio Base.
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Términos de la 
Garantía
E-1
Los equipos de posicionamiento láser y electrónico están 
garantizados contra materiales y fabricación defectuosos siempre 
que sean sometidos a un uso normal y a las aplicaciones descritas 
en el presente Manual. El equipo se encuentra garantizado durante 
el período indicado en la tarjeta de garantía que acompaña al 
producto, que se inicia el día en que el producto es vendido al 

comprador original por los Distribuidores Autorizados de Topcon.1

Durante el período de garantía, TPS, según estime conveniente, 
reparará o cambiará este producto sin cargo adicional. Las piezas 
reparadas y los repuestos serán entregados una vez que el 
comprador devuelva los productos dañados, y éstos serán 
reacondicionados o nuevos. Esta garantía limitada no incluye el 
servicio de reparación de daños al producto que resulten de un 
accidente, desastre, uso incorrecto, uso excesivo o modificación del 
producto.

El cliente puede solicitar el servicio de garantía a un distribuidor 
autorizado de servicios de garantía de TPS. Si el producto es 
enviado por correo, el comprador se compromete a asegurar el 
producto o a asumir el riesgo de pérdida o daño durante el 
transporte, a prepagar los cargos de embarque al centro de servicio 
de garantía, a utilizar el empaque de embarque original o un 
equivalente. El paquete debe incluir una carta en la que se detalle el 
problema y/o defecto del equipo.

1. La garantía contra defectos en la batería, cargador o cable Topcon es 
de 90 días.
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E-2
La única opción que tiene el comprador para cambiar el producto es 
la que se especifica líneas arriba. En ningún caso TPS se hace 
responsable por los daños u otros reclamos que incluyan la pérdida 
de utilidades, pérdida de ahorros u otros daños incidentales o que 
resulten del uso o de la incapacidad para utilizar el producto.
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